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Chapters

1 System description
This chapter presents a general description of the echo sounder system. Refer
to page 1.

2 Display views
This chapter explains the layout of the echo sounderdisplay presentation.Refer
to page 24.

3 Getting started
This chapter provides an operational example to get you started with the
operation. Refer to page 40.

4 Operational procedures
This chapter provides specific procedures for common tasks. Refer to page 50.

5 Reference guide
This chapter explains themenus and dialogue boxes in detail. Refer to page74.

6 Sound Velocity Profile (SVP) Editor
This chapter describes how to use the sound velocity profile editor. Refer to
page 163.

7 EA2Neptune
This chapter explains how to use the EA2Neptune conversion utility.
Refer to page 172.

8 Data and telegram formats
This chapter explains the file and directory names, as well as the various input
and output telegrams. Refer to page 174.
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SYSTEM DESCRIPTION

Introduction
This chapter provides a brief introduction to the EA 400
hydrographic echosounder system.

Topics

→ Overview, page 2
→ System drawing, page 4
→ Wave propagation, page 9
→ Bottom echo, page 11
→ Sidescan, page 13
→ Observation range, page 14
→ Technical specifications, page 15

Important notice

Windows NT, Windows 2000, Windows XP and Windows are
either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Echosounder software version

This manual complies to echo sounder software version 2.3.0.x.
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System overview

Key facts

The EA 400 is a single or multi frequency echo sounder
designed for the professional hydrography community. It can
operate with maximum four frequency channels simultanously.

• The EA 400 system is flexible and easy to configure due to
the modular design.

• The EA 400 is available in two versions. The standard EA
400 system uses a 15 inch LCD with integrated computer,
while the EA 400SP are portable systems.

• The complete EA 400SP is housed in a small rugged
suitcase, IP rated to IP56. It can be operated from a standard
car battery. The power consumption is low. All connections
are made through plugs at one side of the suitcase.

• Echo sounders ranging from relatively low-cost single beam
to large multi-frequency systems can be realised.

• Menus and dialogue boxes are operated with a standard
computer mouse and keyboard.

• Large colour liquid crystal displays (LCD) are used. A
standard computer mouse may be used.

• The EA 400 uses the Microsoft Windows® display interface.
Operation is to a large extent self-explanatory. Getting started
is easy if you are familiar with standard Microsoft
Windows® programs.

• A store/replay function reduces the need for echogram
printout on paper. The unprocessed transducer signal is
recorded on the internal harddisk. During replay, this signal
is injected into the EA 400 processing software as if it
arrived directly from the transceiver.

Main units

The standard EA 400 hydrographic echo sounder consists of one
or more transducers, a General Purpose Transceiver (GPT) and
an LCD unit with integrated computer.

• Transducers are available at frequencies ranging from 38 to
710 kHz.



System description

3857-160981 / J

• The General Purpose Transceiver (GPT) contains transmitter
and receiver electronics. It can be configured for single beam
operation. The receivers are designed for low noise, and they
can handle input signals spanning a very large instantaneous
dynamic amplitude range of 160 dB. All targets are correctly
measured and displayed. Output transmit power per
frequency channel is maximum 2 kW per channel.

• A twisted pair Ethernet cable connects the General Purpose
Transceiver (GPT) with the computer. The distance between
the computer and the GPT can be extended up to 100 meters.

• If more than one transceiver is used, a small Ethernet HUB
or switch is used to connect the General Purpose Transceivers
to the computer.

• Most of the echo sounder functions are implemented in
software. The bottom detection algorithm is implemented
solely in software with separate computation for each
frequency channel.

• When a portable computer is used, the power output is
maximum 1 kW per channel (Optionally, 2 kW is available).

• A rugged and/or splash proof suitcase houses the portable
version, this suitcase contains both the computer and the
General Purpose Transceiver (GPT). The GPT can be
operated from a standard car battery (+12 Vdc) . The PC to
be run from internal battery if the system should maintain the
IP rate.

• Interfaces are provided for depth telegram output as well as
navigation data, temperature sensor and motion sensor inputs.
An external push button may be connected for manually start
and stop of the survey lines.

• An external push button may be added for manual control of
the event triggering.

• Socket interface is included. To run the EA 400 software and
other software (for example survey- or classification
software) on the same computer, this socket interface is
required for data transmission between the software
packages.
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System diagrams
The following system diagrams are provided:
• EA 400 with one transceiver
• EA 400 with two transceivers
• EA 400 with Hydrographic Operator Station (HOS) and two

transceivers
• EA 400SP portable system
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System diagram with one transceiver
1) Display unit 2) Processor unit 3) General Purpose Transceiver (GPT) 4) Transducers
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System diagram with two transceivers
1) Display unit 2) Processor unit 3) General Purpose Transceiver (GPT)
4) Transducers 5) Ethernet HUB or switch
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System diagram with Hydrographic Operator Station (HOS) and two transceivers
1) Hydrographic Operator Station (HOS) 2) General Purpose Transceiver (GPT)
3) Ethernet HUB or switch 4) Transducers A) Navigational data B) Motion sensor data
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Portable system. IP56-rated suitcase with standard laptop or rugged notebook.
1) Portable computer 3) General Purpose Transceiver (GPT) 4) Transducers
A) COM 1 (Navigation) B) COM 2 (Input/output) C) 12 VDC power D) Connector
E) USB connector (Mouse)

(CD24209)
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Wave propagation
The velocity of sound wave propagation in the sea varies
slightly with temperature, salinity and pressure. The velocity
varies between 1440 and 1520 m/s in shallow sea water, while a
velocity around 1480 m/s can be expected at 1000 m depth. In
shallow fresh water the velocity is approximately 1430 m/s.
A good average value to be used in the Environment dialogue
box is 1500 m/s.

Figure 1 The
wave propagation
principles

The EA 400 transmits high energy sound wave pulses into the
sea. A flat bottom reflects the transmitted wave as if it were a
mirror. The propagating energy is spread over a larger and larger
area as it travels down to the bottom and up again. The energy is
spread over a four times larger area every time the travel
distance doubles.
At the bottom there are many small targets. All targets within
the beam angle will be reflected. The area which is covered by
the beam will increase with the square-law or 20 log TVG
(Time Varying Gain) spreading. Bottom of the same type (same
backscatter) will be displayed with the same colour independent
of the depth.
The situation is slightly different when observing the echoes
from individual fish. The transmitted wave undergoes
square-law spreading when travelling from the surface and
down to the fish. The swim bladder of the fish scatters a small
fraction of the arriving energy in all directions. Travelling from
the fish and back towards the surface the scattered wave
undergoes another square-law spreading. The combined effect is
referred to as quad-law or 40 log TVG spreading.
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Propagation losses due to absorption are much higher in sea
water than in fresh water. Absorption also increases with
frequency. At 38 kHz the absorption is 0.5 dB/km in fresh water
and 10 dB/km in sea water. At 200 kHz the absorption is 10
dB/km in fresh water and 50 dB/km in salt water. The echo
sounder must know which water type is present in order to
compensate for these losses correctly.
(The dB (decibel) unit has long traditions in underwater
acoustics and other fields in physics. It is a logarithmic measure
for the ratio between two quantities).

Related topics

→ Environment, page 105
→ Echogram, page 100
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Bottom echo
A hard flat bottom reflects the transmitted signal as if it were a
mirror. The transmitted pulse hits the illuminated bottom area at
nearly the same instant, and the echo from different parts of this
area arrive back at the surface also at nearly the same instant.

Figure 2
Bottom echo

The received echo signal is basically an attenuated copy of the
short transmit pulse. The echo signal from a sloped bottom is
characterised by having a longer duration and a slower rise and
fall time. The transmitted pulse first hits the slope at point A,
and as time elapses the reflection point travels along the slope
towards point B. Many locations do not have a solid hard
bottom. Frequently, the bottom is composed of layers of mud,
clay and sand which can be observed as coloured bands on the
echo sounder display.
The bottom detection algorithm is implemented solely in
software, and separate algorithms are run for each frequency
channel. The algorithm is designed with emphasis on reliability
in the sense that erroneous depth detections are never output.
Whenever the quality of a detection is questionable the
algorithm outputs a depth of 0.00 to indicate that no reliable
detection was obtained. The EA 400 algorithm is designed to
handle a number of difficult situations. The algorithm maintains
bottom lock for a discontinuous jump in bottom depth. It avoids
false bottom detections on a dense school of fish. The algorithm
chooses the upper boundary of the first layer when the bottom
consists of layers.
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The bottom detection algorithm locks to the first good bottom
return. The depth at point A rather than the depth along the
transducer axis will be output for a sloped bottom. The detected
depth value is always smaller than the depth along the
transducer axis implying that a safety margin is automatically
included.
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Sidescan

Specially designed transducers for hull or over-the-side
mounting are available from Kongsberg Maritime for sidescan
operation. The operating frequency is 120 or 200 kHz.

Figure 3 The
sidescan principle

A sonar side looking type of image is generated on the echo
sounder display when pointing this transducer near horizontally.
With a beam width of 50 degrees vertically and only 0.5 or 2
degrees horizontally the scanning sector is narrow enough to
resolve relatively small objects on the sea floor, but wide
enough to allow higher survey speeds than with conventional
side looking echo sounders. Bottom elevations and objects are
immediately recognised on the echo sounder colour display.
Side scan operation can be used for wreck searching and for
surveying navigable channels for obstacles. Monitoring
riverbanks, erosion, land slides and flow induced sediment
deposits are other useful applications.

The software in the EA 400 is prepared for dual sidescan
operation and presentation. The sidescan data is captured and
stored in a digital format. This allows for further data processing
to a sidescan sonar mosaic image by combining data from a
number of survey lines. It is even possible to allocate one or two
vertical channels for normal echo sounding while doing the dual
acoustic imaging.

Note that the EA 400P and EA 400SP are limited to either dual
sidescan or single sidescan with one vertical channel.
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Observation range
Absorption increases dramatically with frequency in salt water.
For maximum observation range you should select a low
operating frequency, a large transducer and the maximum
transmit power.

Maximum detection depth

Transducer
type

Frequency,

kHz

Pulse
duration,
ms

Beam
angle,
degrees

Band
width,
Hz

Transmit
power,
W

Range
bottom,
m

38--7 38 4 7 766 2000 3000

38--9 38 4 9 766 1500 2600

38/200D 38 4 13x21 766 1000 2100

50/200D 50 2 10x16 1493 1000 1400

50--18 50 2 18 1526 500 1400

50--7 50 2 7 1493 2000 1900

120--25 120 1 10 3026 1000 800

200--7 200 1 7 3088 1000 500

710--36 710 1 2.8 3088 100 50

38/200 200 1 7 3026 1000 450

50/200 200 1 7 3088 1000 450

Typical observation ranges are shown in the table. Bottom
detection can be expected to work down to 3000 meters when
using the Simrad 38-7 transducer (37 kHz, 7x7 degrees, 2000
W). However, bottom detection becomes unreliable below 450
meters if you use the Simrad 50/200D transducer (200 kHz,
7x7 degrees, 1000 W)
These range calculations assume a normal sea water salinity
(3.5%) and temperature (+10 degC), an average bottom (surface
backscattering strength = -20 dB) and a noise level typical for a
moving vessel.
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Technical specifications
The following is a summary of the technical specifications for
the EA 400 echo sounder. Note that the specifications may be
changed without prior warning.

Topics

→ Portable system, page 16
→ Echo sounder system, page 17
→ Interfaces, page 18
→ General Purpose Transceiver (GPT), page 19
→ Processor Unit, page 20
→ Operator Station, page 21
→ PC for Portable system, page 22
→ Ethernet HUB, page 23
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Portable echo sounder system
• Frequency channels: 1 or 2 channels
• Operating frequencies: 33, 38, 50, 120, 200, 210 and

710 kHz
• Echogram types

- Surface echogram
- Bottom expansion

• Gain function: 20 log TVG, 30 log TVG, 40 log TVG or
None

• Colour scale: 12 colours (3 dB pr colour)
• Start depth and range: 5 to 15,000 meters in Manual, Auto

range or Auto start modes.
• Ping rate: Adjustable, maximum 20 pings per second
• Bottom detector: Software tracking algorithm, adjustable

minimum and maximum depth
• Scope presentation: Displays the echo strength of the most

recent ping.
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Echosounder system
• Frequency channels: 1, 2, 3 or 4 channels
• Operating frequencies: 33, 38, 50, 120, 200, 210 and

710 kHz
• Echogram types:

- Surface echogram
- Bottom expansion

• Gain function: 20 log TVG, 30 log TVG, 40 log, TVG or
None.

• Ping rate: Adjustable, maximum 20 pings per second.
• Start depth and range: 5 to 15,000 meters in Manual, Auto

range or Auto start modes.
• Scope presentation: Displays the echo strength of the most

recent ping.
• Colour scale: 12 colours (3 dB pr colour)
• Bottom detector: Software tracking algorithm, adjustable

minimum and maximum depth



EA 400

18 857-160981 / J

External interfaces
Numerous external interfaces are provided for the EA 400 echo
sounder system.

Outputs

• Echogram printer (Centronics parallel)
• Depth data (NMEA, Simrad or Atlas)
• Echogram (only on Ethernet)
• Navigation
• Relay navigation
• Motion sensor
• Status messages
• Annotation
• Sound Velocity Profile applied
• Temperature sensor
• Remote display
• Raw data (only Ethernet) (Classification)
• GeoRef data (only network)

Inputs

• Navigation receiver (NMEA)
• Heading (NMEA)
• Motion sensor (Heave, roll and pitch)
• Analogue heave, roll and pitch (+/- 10 V)
• Annotation
• Sound Velocity Profile
• Real time SVP smart sensor
• Transmit synchronization
• Temperature sensor
• Remote On/Off logging
• Remote On/Off pinging
• Remote On/Off history

Remote control toggle switches

• Survey Line
• Event
• Remote power
• Transmit synchronization
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General Purpose Transceiver (GPT)
• Transmit power: Max 2 kW (Single or Dual frequency

transceiver)
• Receiver noise figure: 3 dB
• Transducer impedance: 60 ohms
• Output protection: Short circuit and open circuit protection
• Receiver input range: Instantaneous dynamic amplitude

range -160 dBW to -20 dBW (dB relative to 1W)
• Connectors

- Transducer: 12-pin female Amphenol, Shell
MS3102A-24, Insert 24-19S

- AUI: 15-pin female Delta
- Network: 8-pin RJ-45 socket
- Auxiliary: 25-pin female Delta

• Physical dimensions
- Width: 284 mm
- Height: 112 mm
- Depth: 246 mm

• Weights
- With one TX board: 2.7 kg
- With two TX boards: 3.3 kg

• Supply power and fuses
- AC: 95 to 265 Vac, 50-60 Hz, 50-100 W
- DC: 11 to 15 Vdc, 50-100 W

• Fuses

- AC fuse: Ø5x20 mm, 2 A slow
- DC fuse: Ø5x20 mm, 10 A slow or fast

• Operational temperature: 0 to +55 deg C
• Storage temperature: -40 to +70 deg C
• Humidity: 5 to 95% relative non-condensing
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Processor Unit
The Processor Unit comprises a standard personal computer. It
may be provided locally, but the following specifications are
recommended:
• Processor: Pentium 400 MHz

- Minimum requirement: Pentium 1 GHz
• Memory capacity:

- Minimum requirement: 256 Mb
• Hard disk capacity:

- Minimum requirment: 40 GB
• Disk drives

- 1.44 Mb floppy
- CD-ROM Read/Write

• External interfaces
- Minimum 2 x RS-232 serial lines, recommended 4 x

RS-232 serial lines
- Parallel/USB port
- 2x ethernet RJ-45

• Operating systems: MS Windows 2000 or XP
• Additional software required: Internet Explorer 5.0 (or

later)
• Operational temperature: 0 to +40 deg C
• Storage temperature: -40 to +70 deg C
• Humidity: 5 to 95% relative non-condensing

Note Observe that the maximum total cable length used between the
Processor Unit and the General Purpose Transceiver (GPT) is
100 meters using CAT5 STP 10 Mbit cable.
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Operator Station
The EA 400 is supplied with the HOS 152 Operator Station This
is a 15-inch display with a built-in computer. Optionally, the
larger HOS 192 can be supplied.
Earlier systems included the HOS 151 or HOS 181.
Refer to the applicable documentation provided with the unit for
more information.
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PC for Portable system
The portable echo sounder can be supplied with either a
standard laptop or a rugged tablet personal computer. The
following minimum specifications are recommended:
• Processor: Pentium M
• Memory capacity: 256 Mb
• Hard disk capacity: 40 GB
• External interfaces

- 1 serial port
- 2 USB ports
- Ethernet RJ-45

• Operating systems: MS Windows 2000 or XP
Refer to the applicable documentation provided with the unit for
more information.
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Ethernet HUB
When more than one General Purpose Transceiver is supplied,
the EA 400 will be supplied with an Ethernet HUB. Several
different switches are available. A standard commercial is HUB
supplied with the echo sounder, unless a specific type is
specified by the customer. Further specifications may be found
in the documentation supplied with the unit.
Standard HUB/switch:
• No. of ports: 5
• Network speed: 10 Mbps
• Interfaces: RJ-45 Ethernet and BNC (optional)
• External power supply: 230 Vac
• Power consumption: Max 10 W
• Power frequency: 50 to 60 Hz
• Operational temperature: 0 to +40 deg C
• Storage temperature: -20 to +80 deg C
• Humidity: 5 to 80% relative non-condensing
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DISPLAY VIEWS

Introduction
This chapter provides a brief overview of the information
displayed by the EA 400, and how it is organised.

Related topics

→ Display layout and main view, page 25
→ Moving boundary lines, page 26
→ Direct access to dialog boxes, page 27
→ Menu bar, page 29
→ Header view, page 30
→ Echo frames, page 31
→ Status bar, page 36
→ History and printer views, page 37
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Display organisation

Main view

The EA 400 display is organised as follows (from top):

• Menu bar

• For each transceiver channel:

- One header view

- Two echo frames

• Status bar

A single channel display is shown below as an example.

(CD6744A / BM300)

1 2

3 4

5

(1) Main menu (2) Header view

(3) Echogram and range view (4) Scope view

(5) Status bar
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Menu

The Menu bar contains the echo sounder’s main menu. A
single click on one of the menu names will provide a new
drop-down menu where additional choices can be made.

Header

For each channel, the Header view contains the current
operational mode and frequency, the current depth, and the
colour scale.

Echo frames

The Echo frame takes up the largest part of the echo sounder
window. Each Echo frame contains (from left) the Echogram
and Range view and the Scope view.

The Echo frame view is are also described in more detail in the
Getting started chapter.

Status bar

The Status bar presents the current event and line numbers,
current time, and other information provided by the echo
sounder.

Moving the boundary lines

You can modify the vertical size of the echograms by moving
the horizontal boundary line between the two echograms.

To do this:

1 Position the cursor at the boundary line.

2 Press the left mouse button.

3 Drag the cursor up or down vertically while keeping the
left mouse button pressed.

4 Release the left mouse button.

Using the same operation, you can modify other boundary lines
on the display;

• The horizontal line between the upper Echo frame and the
Header view

• The vertical line between the Echogram and Range view
and the Scope view
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Direct access to dialogue boxes

Several dialogue boxes are directly accessed from the various
views on the display.

Position the cursor, and right-click on the...

• Mode and frequency information in the Header view to
open the Transceiver Settings dialogue box.

• Depth value in the Header view to open the Bottom
Detector dialogue box.

• Colour scale in the Header view to open the Colour Scale
dialogue box.

• Range field in the Echogram and Range view to open one
of the Range dialogue boxes, depending of the current
echogram type.

• Echogram field in the Echogram and Range view to open
the Echogram dialogue box.

”Hidden views” overview

To present all hidden views in one main dialogue box:

• Position the cursor in the Header view.

• Press the left mouse button.

- A list of the dialogue boxes described above will be
displayed in one box, and you will have direct access to
each of them.

This pop-up menu also allows you access to the Status window,
which provides abbreviated information of the current echo
sounder parameters.
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Related topics

→ Menu bar, page 29
→ Header view, page 30
→ Echo frames, page 31
→ Status bar, page 36
→ Getting started; Operation, page 44
→ Bottom Detector, page 93
→ Colour Scale, page 96
→ Echogram, page 100
→ Bottom Range, page 95
→ Status window, page 147
→ Surface Range, page 154
→ Transceiver settings, page 160
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Menu bar
The EA 400 Menu bar contains the Main menu.

(CD24214 / BM300B)

1

(1) The main menu
The main menu has the following options:
• File
• View
• Options
• Interfaces
• Install
• Step!
• Help
• Shortcuts
To operate, click on the menu name and observe the drop-down
menu. Select a new item on the drop-down menu by clicking on
the command. Commands shown with light grey colour are
unavailable in the present configuration or operational mode.
The menus are all explained in the Reference Guide.

Related topics

→ Main menu, page 75
→ Reference guide, page 74
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Header view
The EA 400 Header view is shown directly above the two Echo
frames. The top Header view is thus located just below the
Menu bar. The Header view contains the following
information.

(CD6744C / BM300B)

1 2

4

3
(1) Transceiver settings: Current mode and frequency
(2) Bottom detection: Current depth
(3) Colour Scale
(4) Action field for “hidden dialogue boxes”
(5) Current depth from one ov the other channels. Displayed in
red.
The Header view is a part of the channel. If more than one
channel is displayed, the Header view is duplicated as well.
The Header view provides direct access to the following
dialogue boxes:
• Right-click in the Transceiver settings field (on the Mode

and frequency information) to open the Transceiver
Settings dialogue box.

• Right-click in the Bottom detection field (on the Depth
value) to open the Bottom Detector dialogue box.

• Right-click on the Colour scale to open the Colour Scale
dialogue box.

• Left-click on the Header view to open all hidden dialogue
boxes in one menu.

Related topics

→ Transceiver Settings, page 160
→ Bottom Detector, page 93
→ Colour Scale, page 96
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Echo frames

Overview

The EA 400 Echo frames are the main information bearer on
the echo sounder display. The Echo frames are usually
presented in pairs with two echo frames for each channel.

The Echo frame contains the following views:

• Echogram and Range view

• Scope view

(CD6744D / BM300B)

1
3

4 5

6 2

(1) Echogram and range view

(2) Scope view

(3) Echogram

(4) Echogram with bottom expansion

(5) Range

(6) Depth, coverage and TVG at cursor’s location
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Echogram and Range
The Echogram and Range view consists of an Echogram field
to the left and a Range field to the right. These are separated by
the vertical range axis. The Echogram field contains
information about the acoustical values, while the Range field is
used for specifying the range used in the Echogram field. The
settings in the Colour Scale is used to present the information.
In the echogram field, the presentation can be of different views.
This can be selected in echogram dialogue bok as 1x, 3x, 5x, or
all. Fore examle: If a 20 tranducer system; all selected, 20
echogram in the echogram filed.
When you place the cursor in the Echogram field, you can use
the mouse wheel to modify the TVG value, and hence the
display colour sensitivity. Each click of the wheel corresponds
to a 1 dB change. The same colour sensitivity setting is
available from the Colour Scale dialogue box.
Whenever the cursor is located within the Echogram field, a
small yellow label is visible. The label provides the following
information:
• Left: Depth at the cursor position
• Middle: Diameter coverage from the transducer beam
• Right: Current TVG value

Note This information is only valid when #x echogram is selected.

To change the range, you can also use the mouse wheel. Place
the cursor inside the Range field to do this:

• In a surface related echogram you will modify the range,
while for a bottom related echogram, you will change the
start range.

• If you press the left mouse button while you use the mouse
wheel, the surface echogram will change its start value, while
the bottom related echogram will change its range.

Related topics

→ Getting started, page 45
→ Colour Scale, page 96
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Scope
The Scope view is the rightmost view and shows a oscilloscope
view of the last ping corresponding to the settings in the
Echogram view.
This view draws a range of horizontal symmetrical colour lines.
The distance from the vertical centre axis and the line colour
reflects the received echo amplitude. A black horizontal line
across the view indicates the current bottom view.
If you press the right mouse button with the mouse pointer
positioned in the Scope view, the graphic presentation will be
replaced by a text based presentation of the data. The following
information is provided:
Channel:

Test presentation for passive or test mode
Passive:
Background Noise: yyy.y dBW
Receiver Amplitude: xxx.x dBW
The background noise shown is the median of 20 equidistant
power samples in the total range of the current ping. The
receiver is sampled at 100 m depth. During replay, you may find
that this depth setting is not available because the depth is less
than 100 m. The receiver amplitude is then set to a minimum
(235 dBW).
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Sidescan

If the necessary transducers are available, the EA 400 can be set
up as a “sidescan sonar” with only a few easy commands. Two
echograms are used, but a third channel may be added to show
the current depth, provided that suitable hardware is installed.

(1) Sidescan echograms

(2) Depth echogram

(3) Sidescan range

(4) Annotation / Position

(5) Distance information

(6) Vertical depth (ext. depth)

1
2

3 4

5

6

(CD2407B)

The illustration shows an excerpt from the echo sounder display.
It shows a dual sidescan presentation in the upper frame, and a
third channel in the lower frame providing current depth.

The sidescan echogram scrolls in its vertical direction.

To change the sidescan range, place the cursor inside the
sidescan range field. Click the right mouse button to open the
Sidescan Range dialogue.

When you place the cursor in the sidescan echogram, the
distance from the transducer to the object is given at the cursor
position.
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To export the position of an object, click on the left mouse
button in the side scan echogram view. The position will be
displayed in the status bar (bottom left of the display).
Simultaneously this position is also marked in the view by a red
cross.
The position is exported on the network. The port is defined in
the Network menu. This function will be carried out
automatically, so no tag has to be activated.
A specific procedure in the Operational Procedures chapter
explains how to set up the sidescan option.

Related topics

→ Operational procedures, page 71
→ Sidescan Range dialogue, page 146
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Status bar
The EA 400 Status bar is located at the bottom of the display.
It contains the following information:
Note that the water temperature read-out will only be available
if a sensor is connected to the echo sounder. Also, navigational
information requires that the applicable position information is
connected to the echo sounder.

(CD6744E / BM300D)

1 2

3

4

5

6

7

8

(1) Information applicable for the current operation
(2) Event number
(3) Printer logo (when printer is active)
(4) Current temperature
(5) Line number
(6) History file number
(7) Navigational information (latitude and longitude)
(8) Time

Related topics

→ Status bar, page 83
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History and printer views

Overview
The echogram information provided on the display will differ
slightly from the information provided on the printer and in the
History files. This is because the annotation settings differ
between the two media.

The annotations provided for display output are controlled by
the Annotations dialogue box. When enabled in the Prister
and History dialogue box, the annotations will also be sent to
the printer and to the History files.

The Printer and History dialogue box also enables additional
annotations to be printed.

Related topics

→ History, page 114
→ Annotations, page 90
→ Printer and History, page 129

Display example
The echogram shown on the display will contain a vertical red
line for every annotation selected in the Annotation dialogue.
The line is identified with free text entered in the dialogue box.

Figure 4 Display
example with a

single text
annotation
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Printer example

A printout from the echo sounder is shown below.

Figure 5 History and printer presentation

1 9

2
3 5 7

8

6

4

(CD10210)

From the top left corner, you can see the following annotations.

(1) A depth annotation. This information will automatically
appear at regular intervals, and whenever you change the echo
sounder’s depth range.

(2) An external annotation with the text “This is an ATS
annotation”. This annotation has been imported on the serial line
from the navigation system.

(3) Two annotations with navigational information. This
information appears with regular intervals when enabled from
the Printer and History dialogue box.
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(4) One Event annotation with both navigational and time
information added. This annotation is controlled by the
parameters in the Annotation dialogue box. It will only appear
on the printer output and in the History when you press the
Event number in the Status bar.
(5) One annotation with navigational information. This is
identical to item 3.
(6) One Text annotation with the text “Test in Horten”. This text
is entered in the Annotation dialogue box. You will need a
keyboard connected to your echo sounder to do this.
(7) Two annotations with navigational information. This is
identical to item 3.
(8) One Event annotation with no additional information added.
The number shown (”0006”) is the event number. The
annotation appears on the printer output and in the History when
you press the Event number in the Status bar .
(9) One depth annotation. This is similar to item (1).
(Others) Several other annotations to provide examples.
To add Text, Time and Event annotation, you must open the
Annotation dialogue box. This box is accessed from the File
menu.
Additional text to the printer and History window is controlled
by the parameters in the Printer and History dialogue box. This
box is accessed from the File menu.
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GETTING STARTED

Introduction
This chapter will guide you through the main operations of the
EA 400 by the use of an operational example. The intention
with this chapter is to provide you with an overview of the main
functions in the echo sounder, and to demonstrate how the EA
400 may be used in a realistic operational situation.

Topics

→ Before you start, page 41
→ Start-up, page 42
→ Operation, page 44
→ Data storage, page 48
→ Operational procedures, page 50
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Before you start
Before you start the EA 400, make sure that the necessary
hardware items are correctly installed and connected. The
transducer(s) must also be defined in the EA 400 software on
the computer.

EA computer IP setting
If the computer is supplied by Kongsberg Maritime, the
following address(es) and parameter(s) are entered and checked
out.
The computer’s default IP address is 157.237.16.12 and the sub
mask is 255.255.0.0. These addresses fit the IP address for GPT
transceiver.
→ See page 115

If use of other address, both computer and GPT must be
changed (for example: 10.10.x.x . The numbers 10.10. must be
equal in both computer and GPT).
If two network cards in the computer, the network for GPT must
be 1. priority. Refer to “Network Connection” and “Advanced”
on your computer.

Firewall and other security software
Be aware that if the Windows Firewall is “on”, the network
communication can cause some problems. Turn it off or choose
“UNBLOCK”. Other type of security program can cause same
problem.

Related topics

→ Physical installation, see the Instruction Manual.

Refer to the installation instructions in the paper manual for
more information.
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Start-up

Overview
This chapter provides the basic procedure required to power up
the echo sounder and start the pinging.

Power-up procedure
After these initial preparations you can open the EA 400
program on the computer. The “power on” procedure is
described in detail in the Operational procedures chapter.

The menu system
The menu system is based on the Microsoft Windows®
commercial standard interface. An overall explanation of the
menu system with a description of the various views are
presented in the Display views chapter.

Transceiver inspection
First, we need to check that the transceiver (or transceivers) are
connected.
Open the Install menu, choose the Transceiver command to
open the Transceiver Installation Mode dialogue box. In this
dialogue, press the Inspect button to open the Transceiver
Settings dialogue box.
You may now check that the transceivers are installed correctly.
Active transceivers appear in green text in the Frequency
Channel Selection box.
Click the Cancel button to finish.
If none of the transceivers listed appear in green text, check the
connections and re-install the transceiver(s).

Environmental parameters
To obtain correct values for the various acoustical parameters
calculated by the EA 400 program, it is important that you
provide the EA 400 program with accurate parameters
describing the environment; sea temperature, salinity and sound
velocity.
These values are defined in the Environment dialogue box.
Open the Install menu, choose the Environment command to
open the Environment dialogue box.



Getting started

43857-160981 / J

Unless the default values are acceptable, you must enter data for
salinity, sound velocity and water temperature. These values are
used for calculating depths and absorption coefficient. The
values must be as accurate as possible!

Click OK when you have finished.

Navigation interface

To link acoustical data with navigational data the EA 400 must
be able to receive data provided by a GPS or another positioning
system. The Navigation Interface dialogue box is used to
define the parameters to achieve this.

Open the Install menu, choose the Navigation command to
open the Navigation Interface dialogue box.

Specify how the EA 400 will receive navigational data. Since
the NMEA standard has been implemented, you only need to
choose between NMEA or ASCII.

If ZDA clock is available, the PC system clock can automatic be
synchronised with ZDA input. Then choose “Automatic Set
Clock”.

Click OK when you have made the setting.

Additional interfaces

Additional interfaces have been provided for other peripheral
systems.

If you want to use a heave or a temperature sensor, choose the
Heave and Temperature commands on the Install menu to
specify these interfaces.

Related topics

→ Power on/off procedure, page 51

→ Display views, introduction, page 24

→ Frequency channels installation procedure, page 58

→ Transceiver Installation, page 158

→ Transceiver Settings, page 160

→ Environment, page 105

→ Navigation Interface, page 120

→ Heave Sensor, page 111

→ Temperature Sensor, page 157
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Operation

Overview
This chapter describes a few of the most common functions used
during normal operation.

Selecting operational mode
You are now ready to start the actual operation of the EA 400
echo sounder. The first thing to do is to choose operational
mode.
Open the File menu, choose Operation to open the Operation
dialogue box. In the Mode group, click Normal for normal
mode.
(You may alternatively click Replay for replay mode, but you
must then also click Files to choose a replay file. Note that
operating in replay mode will restrict you from changing certain
parameters during operation.)
Next, you need to define the ping rate. To do this, locate the
Ping Rate group box, and set the ping rate to Interval for
manual setting of the ping interval. For this exercise, set the
ping interval time to 1 second, and click OK to finish.
The echo sounder will now start pinging, and after a few
moments the echogram field on the display will present a new
echo line. The various fields on the display are explained in
detail in the Display views chapter.

Transceiver settings
The operational mode and the transceiver frequency are
displayed to the far left in the Header view. A dedicated
dialogue box - Transceiver Settings - is used to define various
parameters associated with the transceiver. These settings
include transceiver mode, the depth of the transducer surface,
the transmit power, and the pulse length.
To open this dialogue box, position the cursor over the mode
and frequency information in the Header view, and click the
right mouse button. Specify the estimated depth of the
transducer surface, and set Transmit Power to its maximum
value. Set the Pulse Length to a medium value of 1.024 ms (for
38 kHz), and click OK to accept the settings.
The chosen pulse length will result in an acceptable resolution
of approximately 0.75 m, and acceptable signal-to-noise ratios at
the depths considered in this example.
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Note that if you operate in Replay mode, the transceiver settings
can not be changed.
Additional information about the transceiver settings are
available if you press the Advanced button in the Transceiver
Settings dialogue box.

Bottom detector settings
The Header view on the display is also used to present the
current depth. The Bottom Detector dialogue box is used to
define various parameters associated with the bottom detection.
These include the depth range, where the EA 400 searches for
the bottom.
The EA 400 can also use the Detect Second Layer Bottom
function when using depth from a high frequency transducer.
This function is only used when the second layer is to be
displayed. Do not use for hydrographic surveying.
To open the Bottom Detector dialogue box, position the cursor
over the displayed depth in the Header view, and click the right
mouse button.
In our example we will assume that the depth will vary between
30 and 200 meters. Therefore, set Minimum Depth to 30 m and
Maximum Depth to 200 m. Click OK to accept the settings.

Note Setting both Minimum Depth and Maximum Depth to 0 m will
turn off bottom detection.

Colour scale
The Colour Scale field is used to display the colour scale for
mapping acoustical values. These colours are used in the
Echogram And Range view. Each colour always represents a
3 dB value range. Using all 12 colours in the colour scale thus
enables mapping of a 36 dB value range to colours.
Position the cursor over the colour scale, click the right mouse
button to open the Colour Scale dialogue box. Accept the
default settings and click OK.

Echogram and Range view
The Echogram and Range view consists of an Echogram field
to the left and a Range field to the right. These are separated by
the range axis. The Echogram field contains information about
the acoustical values, while the Range field is used for
specifying the range used in the Echogram field.
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Echogram field

The Echogram field is used to display acoustical values for
each ping. The settings in the Colour Scale are used to
determine the colour sensitivity in the echogram.

Position the cursor in the Echogram field, and click the right
mouse button to open the Echogram dialogue box.

The Echogram dialogue box allows you to define the area of
interest for the echogram. Your choice will affect the meaning
and the options in the Range field in the Echogram view. You
can also choose the TVG function used to calculate the
acoustical values.

In this example, choose Surface – Manual to enable a surface
related echogram. Then, choose the Bottom gain TVG function
for calculating sV-values. Finally, click OK to accept the
settings.

Range field

The Range field allows you to read and specify the range used
in the Echogram field. The current range is displayed on the
range axis. In the Range dialogue box you can define the area of
interest for the echogram.

Position the cursor in the Range field, click the right mouse
button. Observe a dialogue box referring to either Surface or
Bottom depending on your choice in the Echogram dialogue
box.

In this case, check that you have the Surface Range dialogue
open.

Set Range to 200 m and Start Relative Surface to 0 m, then
click OK to accept the settings.

Comments to the Echogram and Range view

Two echograms are shown for each Channel. The second
echogram for the present Channel may be used in the current
example to show the distribution of fish close to the bottom.

• Use the Echogram dialogue in the second Echogram view
to set the Echogram to Bottom and choose the 20 log TVG
function for calculating SV-values.

• Use the corresponding Bottom Range dialogue to set Range
to 20 m and Stop Relative Bottom to 5 m for the echogram
to show values calculated from 15 m above the detected
bottom to 5 m below the bottom.
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When you place the cursor in the Echogram field, you can use
the mouse wheel to modify the receiver gain level, and hence
the display colour sensitivity. Each click of the wheel
corresponds to a 1 dB change. The same colour sensitivity
setting is available from the Color Scale dialogue box.
Whenever the cursor is located within the Echogram field, a
small yellow label is visible. The label provides the following
information:
• Left: Depth at the cursor position

• Middle: Diameter coverage from the transducer beam
• Right: Current TVG range

To change the range, you can also use the mouse wheel. Place
the cursor inside the Range field to do this:
• In a surface related echogram you will modify the range,

while for a bottom related echogram, you will change the
start range.

• If you press the left mouse button while using the mouse
wheel, the surface echogram will change its start value, while
the bottom related echogram will change its range.

Scope view
The Scope view is the rightmost view and shows a scope view
of the last ping corresponding to the settings in the Echogram
view.
This view draws a range of horizontal symmetrical colour lines.
The distance from the vertical center axis and the line colour
reflects the received echo amplitude. A black horizontal line
across the view indicates the current bottom view.

Related topics

→ Display views, introduction, page 24
→ Transceiver Settings, page 160
→ Advanced Transceiver, page 88
→ Bottom Detector, page 93
→ Colour Scale, page 96
→ Echogram, page 100
→ Surface Range, page 154
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Data storage

Overview
This chapter presents a brief description of the data storage
functionality.

Define storage parameters
It will often be beneficial to store raw acoustical data recorded
during a survey. This allows you to change certain parameter
settings when operating in replay mode at a later time.
Open the File menu, choose Store to open the Store dialogue
box.

Note Note that Store is not available when operating in Replay mode.

The Store dialogue box allows you to set various parameters
associated with data storage. You can define a specific directory,
and limit the file sizes.
Click Browse in the Survey box. Browse to the desired
directory for file storage, or enter the directory name directly
into the text box. If the directory does not exists it will be
created.
Default directory is EA 400\data\
Click the Save Raw Data check box to save raw data. Define
maximum file sizes by entering the desired value in the Max
File Size box, and click OK to accept the settings.
When Save Raw Data is checked, the raw unprocessed
transceiver data containing amplitude and angle information for
the split beam transducers will be recorded.

Start and stop data storage
To start and stop data storing, use the Line field in the Status
bar. The Line field is marked LXXXX and shows the current
survey line number.
Position the cursor over the Line field in the Status bar and
click the left mouse button. Observe that the survey line number
increments, and that the line colour changes from black to red.
To stop data recording click the Line field again.
The red colour indicates that data recording is active. When the
recording stops, the colour is changed back to black. The file
names used for the stored data are determined by the survey line
number and the date and time when recording started. A new
file is created for each new survey line number.
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Note that the depth range used for data collection and data
storing is determined from the maximum range settings in the
Echogram view, the bottom detection settings, the settings for
Echogram Parameters, and the settings in the Network
Interface dialogue box.

Related topics

→ Store, page 148.
→ Echogram Parameters, page 104.
→ Network Interface, page 123.
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OPERATIONAL PROCEDURES

Overview
This chapter contains a number of specific procedures to be
used with your EA 400 echo sounder.

Topics

→ Power on/off, page 51
→ Basic operations, page 53
→ Transceiver installation, page 58
→ Record and playback, page 60
→ Software installation and upgrade, page 67
→ Sensor setup, page 69
→ Sidescan, page 71
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Power on/off
Use the following procedures to switch the EA 400 echo
sounder on and off.

Power on
It is assumed that the echo sounder’s hardware and software are
properly installed and configured.
1 Switch power on.

- The location of the power switches are individually
assigned. The computer has its own power switch. The
transceiver(s) must be connected to separate power
supplies, and should have a remote power switch.

2 Observe the hardware test messages and operating system
start-up messages.
- It takes a couple of minutes before the echo sounder

window appears on the display.
The echo sounder memorises all its settings when power is
switched off.
If pinging does not start you must check the settings in the
following dialogue boxes:
• Operation

• Layout

• Transceiver Settings

• Transceiver Installation

If you are not successful you should use this procedure:
1 Check the Transceiver Installation dialogue box.
2 All frequency channels must be properly installed.
3 Select Factory settings in the Options menu.

Power off
To switch off the EA 400 echo sounder, observe the following
procedure.
1 Select Exit on the File menu.
2 Allow the computer to close all the EA 400 software

applications.
- If desired, EA 400 can now be restarted using the

desktop icon.
3 Switch off the power on the General Purpose Transceiver

and other peripherals (if any).
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When the EA 400 software has closed down, you may wish to
close down the computer as well.
1 Click on the Start button in the lower left corner of the

display.
2 Exit the operating system in the normal manner.
3 When notified, switch off the power.

Related topics

→ Operation, page 126
→ Layout, page 118
→ Transceiver Settings, page 160
→ Transceiver Installation, page 158
→ Options menu, page 78
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Basic operations

Overview
This chapter presents a number of common procedures
frequently carried out on the EA 400 echo sounder.

Changing the echogram settings
To change the echogram settings:
1 Position the cursor in the Echogram field.
2 Click the right mouse button.
3 Observe the Echogram dialogue box.
4 Make the required changes.
or:
1 Left-click in the Header view, and select the required

dialogue box from the pop-up menu.
2 Make the required changes.

Related topics
→ Echogram, page 100

Changing the range
To change the range:
1 Position the cursor in the Range field.
2 Click the right mouse button.
3 Observe the Bottom Range or Surface Range dialogue

box.
4 Make the required changes
or:
1 Left-click in the Header view, and select the required

dialogue box from the pop-up menu.
2 Make the required changes.
or:
1 Place the cursor in the Range field.
2 Use the mouse wheel to change the range.

Related topics
→ Bottom Range, page 95
→ Surface Range, page 154

Changing the vertical resolution
The vertical resolution of the echogram increases with a shorter
pulse length.
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For example, a pulse length of 1.024 millisecond gives a vertical
resolution of 19.2 cm, whereas a pulse length of 0.256
millisecond gives a vertical resolution of 4.8 cm. If the vertical
distance between two echoes is less than this, the two echoes
will be shown as one

To change the pulse length:

1 Position the cursor over the frequency information in the
Header view, and click the right mouse button.
- The Transceiver Settings dialogue box opens.

2 Move the pulse length slider to the desired pulse length
value.

3 Click Ok.

or:

1 Left-click in the Header view, and select the Transceiver
Settings dialogue box from the pop-up menu.

2 Make the required changes.

A small value gives the best resolution, while larger values are
mostly used for surveys in deep waters.

Related topics

→ Header view, page 30
→ Transceiver Settings, page 160

Changing the transmit power

To change the transmit power:

1 Position the cursor over the frequency information in the
Header view, and click the right mouse button.
- The Transceiver Settings dialogue box opens.

2 Move the transmit power slider to the desired value.

3 Click Ok.

or:

1 Left-click in the Header view, and select the Transceiver
Settings dialogue box from the pop-up menu.

2 Make the required changes.

Related topics

→ Header view, page 30
→ Transceiver Settings, page 160
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Setting minimum and maximum depth
Setting the minimum and maximum depth controls where the
echo sounder will search for bottom lock.

Note Setting both Minimum Depth and Maximum Depth to 0 m will
turn off bottom detection.

1 Position the cursor over the depth information in the
Header view, and click the right mouse button.
- The Bottom detector dialogue box opens.

2 Set minimum and maximum depth to the desired values.
3 Click Ok.
or:
1 Left-click in the Header view, and select the Bottom

Detector dialogue box from the pop-up menu.
2 Make the required changes.

Related topics
→ Header view, page 30
→ Bottom Detector, page 93

Enabling the depth alarms
You can set individual alarms for minimum and maximum
depth. You can also enable an alarm to sound off if the bottom
track is lost.
1 Position the cursor over the depth field in the Header

view, and click the right mouse button.
- The Bottom detector dialogue box opens.

2 Set the values for minimum and maximum depth alarm.
3 Enable the alarms by ticking the appropriate boxes.
4 Enable the Bottom Lost Warning if required.
5 Click Ok.
or:
1 Left-click in the Header view, and select the Bottom

Detector dialogue box from the pop-up menu.
2 Make the required changes.

Related topics
→ Header view, page 30
→ Bottom Detector, page 93
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Adding annotations
You can add several different annotations to the displayed and
printed information. All annotations are automatically
displayed, while you need to enable the annotations to be
printed.

Enable annotations to be printed

1 Select Print on the File menu.
- The Printer and History dialogue box opens.

2 Under Text to printer, click Annotation.
3 Click OK to exit.
The annotations will be printed until this procedure is repeated.

Enter annotations

Three different annotations may be controlled from the
Annotations dialogue box.
1 Select Annotation on the File menu.

- The Annotation dialogue box opens.
2 To enter a single text annotation to the display:

a Enter the desired annotation text into the Text box
b Click OK.
c The text you entered is displayed immediately, but it

will not be repeated.
3 To add the current time as an annotation:

a Under Time, click Active.
b Enter the desired interval (in seconds) between the

annotations.
c Click OK.
d The annotation will be repeated at the chosen interval

until it is switched off.
4 To add an event annotation:

a Under Event, select a start number.
b Click Increase or Decrease to count the Event number

up or down.
c Click Add Time if you wish the event annotation to

include the current time.
d Click Add Navigation if you wish the event annotation

to include the current position.
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e Click the Event button on the Status bar every time
you wish the annotation to be added to the display
and/or print.

Enable external annotations

The echo sounder will accept external text annotations when
these are input on the serial line and Ethernet. This function is
permanently enabled.

Related topics

→ Annotation, page 90
→ Printer and History, page 129
→ Annotation format, page 91
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Transceiver installation

Overview
Use the following procedures to install, modify or delete
frequency channels from the echo sounder set-up.
General Purpose Transceivers (GPT) physically connected to the
echo sounder’s Ethernet interface are identified automatically by
the system. When you open the Transceiver Installation
dialogue box from the Install menu, a list will be provided.
A single frequency transceiver occupies one entry in the list, and
a dual frequency transceiver occupies two. Each entry is
identified as a frequency channel, and the line displays the
parameters for the channel. Entries in the frequency channel list
are shown in black, green or red colour identifying its current
status.

To install a channel
1 Select Transceiver on the Install menu.
2 Select Modify in the Transceiver Installation Mode

dialogue box.
- The Transceiver Installation dialogue box opens, and

you are allowed to make changes.
3 Click the desired entry (one of the black colour line

alternatives) in the Frequency Channel Selection list.
4 Assign a transducer by selecting a transducer name in the

Transducer Selection list.
5 Click OK to accept the choice and exit the dialogue box.
6 Restart the echo sounder as described below.

To uninstall a channel
1 Select Transceiver on the Install menu.
2 Select Modify in the Transceiver Installation Mode

dialogue box.
- The Transceiver Installation dialogue box opens, and

you are allowed to make changes.
3 Click the desired entry in the Frequency Channel

Selection list.
4 Select the alternative NONE in the Transducer Selection

list.
5 Click OK to accept the choice and exit the dialogue box.
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6 Restart the echo sounder as described below.

To modify an IP address
This procedure allows you to modify the IP address of the
currently selected General Purpose Transceiver (GPT).
1 Select Transceiver on the Install menu.
2 Select Modify in the Transceiver Installation Mode

dialogue box.
- The Transceiver Installation dialogue box opens, and

you are allowed to make changes.
3 Select the General Purpose Transceiver (GPT) you wish to

modify.
4 Click the Set New GPT IP Address button.

- The IP Address dialogue box opens.
5 Enter the new IP address.

- The significance of the address numbers is described
with the IP Address dialogue box.

6 Click OK to accept the choice and exit the dialogue box.
7 Click OK to exit the Transceiver Installation dialogue

box.
8 Restart the echo sounder as described below.

Related topics

→ Transceiver Installation, page 158
→ IP Address, page 115

Restart the echo sounder
Whenever a change has been made to any of the frequency
channels, you must restart the echo sounder.
1 Select Operation on the File menu.

- The Operation dialogue box opens.
2 Select Normal operation, and click OK.

Related topics

→ Operation, page 126
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Record and playback

Overview
You can set up the echo sounder to record the unprocessed
transducer signals on the internal harddisk or other recordable
media. This recorded signal may later be injected into the echo
sounder’s processing software as if it arrived directly from the
transceiver.
During this replay, you may experiment with some of the echo
sounder settings.
This feature is useful during training and demonstration. It is
also useful for memorising a particularly interesting observation
from the survey.
You can also use the built-in History function to record
echogram data.

Record

Preparations

The recording is prepared as follows.
1 Select Store on the File menu.

- Observe the Store dialogue box appear.
2 Select the complete path of the survey directory.

- The directory is selected when you click the OK
button. Click the Browse button if you wish to navigate
through the disk directories. A new directory is created
if the requested does not exist.

3 Select if you wish to save raw data, output data, xyz data,
echogram data, text data or feoref data:
- Raw data: The unprocessed transceiver data are stored

in standard computer files. These files contain all the
necessary data for reconstruction of the situation during
the real survey. Thus the data include amplitude, phase,
navigation data, annotation input etc. The echo sounder
program reads these files during replay.

- Output data: This is the processed output data;
navigational data, bottom detections, annotations etc

- xyz data: This is processed and interpolated xyz data
in ASCII format. Note that navigation input must be
available.

- Echogram data: This is user defined excerpts of the
processed sample data (pixel data), ie the backscatter
value of the targets. The echograms are stored as time
tagged datagrams in separate files.
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- Text data: This is stored depth data and raw navigation
data in ASCII format.

Note Navigation input must be available.

- Georef data: This is the stored vessels interpolated
position lat/long, heading across range and depth. In
the vertical view, only lat/long and depth..

4 Enter the maximum size of the storage files.
5 Select the initial line number.
6 Enter the maximum size of each replay file.
7 Click Ok.

Start recording

Use the Line field in the Status bar to start the recording.
1 Position the cursor over the Line field.
2 Press the left mouse button.
The line number increments, and the Line field is presented
with a red colour.

Stop recording

To stop the recording:
1 Click the Line field once again.

- The original colour is restored.
The recording may also be stopped from a remote position if
this function has been made available.

Size of stored raw data

The total size of raw data files stored on disk during operation
depends on several user selections. From these selections you
may estimate approximately the total amount of raw data stored
in a given time period for each installed channel using the
following equation:
X = (B bytes per sample) S ((8 S R) / (c S tau samples per ping))
S (M ping per sec) S 24 S (3600 sec per day) S (K days)
Where:
X = Total amount of stored raw data in bytes for one channel
B = 2 (Given by the echo sounder)
R = Maximum range in meters (User set)
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c = Sound speed in water in meters per sec (User set)
tau = Pulse duration in seconds (User set)
M = Ping rate in ping per seconds (User set)
K = Number of operating/storage days (User set)
Thus, you can affect the amount of stored raw data by changing
e.g. the range, pulse duration, and ping rate settings.
Example:
With range = 10 m, pulse length = 256 μS, 15 pings per second
and sound velocity = 1500 m/s, the storage requirement will be
45 Mb per hour. If you increase the range to 80 m, and reduce
the ping rate to 7 pings per second, the storage requirement will
be 60 Mb per hour.

Related topics

→ Store, page 148
→ Status bar and Line field, page 83

Playback
When replaying the recorded signal, the ping rate is not limited
by the speed of sound in water. Hence, a higher ping rate is
possible during replay than during normal operation.
The playback is started as follows:
1 Select Operation on the File menu.

- Observe the Operation dialogue box appear.
2 Click Replay.
3 Click Files...

- Observe the Replay dialogue box appear.
4 Select survey with the standard file selection dialogue.
5 Click on the file(s) you wish to replay.

- Observe that the currently selected file(s) appear in the
Selected files list box.

6 Click Loop if you wish the replay to loop through the
selected file(s) endlessly.

7 Click Save Data if you wish to record the file(s) in
processed format during playback.

8 Click Change Installation if you wish to change sensor
setup values, x, y, z or draught.

9 Click Change SVP Profile if you wish to change the
sound velocity profile during replay.
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10 Click OK to return to the Operation dialogue box.
11 In the Operation dialogue box, click OK to start the

playback.
If you do not select Loop, the replay is stopped when the last
recorded ping has been processed.

Related topics

→ Operation, page 126.
→ Replay, page 136.
→ Reprocess heave, page 139.

History
The History function is used to store echograms on bitmap
format. The echo sounder may continuously save echogram
pictures to the internal harddisk or an other recordable media.
These can later be recalled on the display. The information in
the History window is the same as on the printer.
The horizontal width of each echogram picture roughly
corresponds to the the half width of the display. The information
is stored as separate data files on the harddisk, and only the disk
size limits the space for History files. The history function
allows you to quickly look through echogram pictures covering
several hours.

Record

The History recording can either be started with the procedure
described below, or simply be pressing the History button on
the Status bar. The text in the Status shifts to red when the
recording is active.
To start History recording:
1 Select Operation on the File menu.

- Observe the Operation dialogue box appear.
2 Click Browse to select disk directory.

- Default directory is EA 400\history\
3 Create a new directory if required.
4 Click Save in the History field, or
5 Optionally, click Synchronize with logfile in the History

field.
- The history files will switch as the data log files are

switched.
6 Click Ok to start the recording.
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- The text in the History field on the Status bar is red
while recording takes place.

Alternative method for History recording:
1 Select Operation on the File menu.

- Observe the Operation dialogue box appear.
2 Optionally, click Synchronize with logfile in the History

field.
- The history files will switch as the data log files are

switched.
3 Click Browse to select disk directory.
4 Click the History button on the Status bar to start the

recording.
- The text in the History field on the Status bar is red

while recording takes place.
To stop History recording:
1 Select Operation on the File menu.

- Observe the Operation dialogue box appear.
2 De-select Save.
3 Click Ok.

Playback

To view the information recorded by the History function:
1 Select History on the View menu.
2 Browse the information in the History dialogue box.
The information provided by the History view is presented in a
separate window. The echo sounder will operate normally in the
background. However, you will not have access to any of the
menues as long as the History window is open. When you wish
to focus on the echo sounder operation, close or minimize the
History window.

Print the current History information

To print the current view in the History window:
1 Select History on the View menu.
2 Press the printer symbol in the bottom right corner to print

a single history file.
- Note that only the file presented on the display is

printed.

Print multiple History files

To print several images recorded by the History function,
follow this procedure.
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A

B
(A) Press to print current view
(B) Press to print multiple views
1 Select History on the View menu.
2 Browse the information in the History dialogue box until

you find the images you wish to print.
3 Press the left printer icon (with the + sign) in the lower

right corner of the History window.
4 Press the Ctrl key on the keyboard and the left mouse

button simultanously to select the images to be printed.

5 Press the right mouse button, observe the shortcut menu.
6 On the shortcut menu, select Print.
7 Press Cancel to close the dialogue box.

Related topics

→ History window, page 37
→ History, page 114
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→ Status bar; page 83
→ Operation; page 126
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Software installation and upgrades

Overview
The echo sounder is initially delivered with all necessary
software installed and configured. Software upgrades are useful
if your echo sounder fails, and you suspect a software error. An
upgrade is also required whenever the echo sounder software is
modified.
The computer should automatically detect the insertion of the
CD-ROM and open the Installation program dialogue box. If
this is not the case, you must manually run the Setup.exe
program on the CD-ROM’s root directory.
When the echo sounder software is upgraded, the software will
automatically detect the presence of General Purpose
Transceiver(s), but you will need to check that the correct
transducer(s) are enabled.
Whenever new echo sounder software is installed, you will need
to define all serial lines, transducer(s) and transceiver(s).

Related topics

→ Transceiver installation procedure, page 58.

Software installation procedure
Use this procedure if you need to install the software on a new
computer. Note that minimum hardware and software
requirements must be met by the computer.
1 Power up the computer.
2 Insert the EA 400 CD-ROM.
3 Observe the Installation program dialogue box open.
4 Press Complete installation.
5 Allow the echo sounder installation to run. Follow the

instructions provided.
Do not remove the CD until the computer has powered up and
rebooted after the installation.

Software upgrade procedure
Use this procedure if you wish to reinstall the software, or
receive a new CD-ROM with a software upgrade.
1 Power up the computer, and allow the EA 400 to start.
2 Close the EA 400 program by selecting File - Exit.



EA 400

68 857-160981 / J

3 Insert the EA 400 CD-ROM.
4 Observe the Installation program dialogue box open.
5 Press Update installation.
6 Allow the echo sounder files to be copied from the

CD-ROM to the computer’s hard disk.
Do not remove the CD until the computer has powered up and
rebooted after the installation.

Un-installation procedure
Use this procedure if you need to remove all the echo sounder
software from the computer. Note that all data in the EA 400
directory will be erased.
1 Power up the computer.
2 Insert the EA 400 CD-ROM.
3 Observe the Installation program dialogue box open.
4 Press Uninstall.
5 Allow the echo sounder un-installation program to run.

Follow the instructions provided.
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Sensor setup

Overview

In order to ensure that the data from the vessel’s heave sensor
are interpreted and used correctly by the echo sounder, you must
position the heave sensor’s location in respect to the transducer.
Both locations are then referenced to the vessel’s global
Reference point.
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Figure 6 The Vessel Coordinate system

(1) Downwards (2) Starboard (3) Forward
(R) Reference point

The theory

A main function of the parameters required for system
installation is to inform the system of the relative positions
between the various sensors and the angular orientation of the
sensors with respect to the vessel. A reference point somewhere
on the vessel has to be selected, and a Cartesian right-handed
coordinate system - as shown in the figure below - must be
defined with its origin in the reference point. The location of
this reference point has no physical significance - it may be
anywhere on the vessel. The placement of the various
instruments must be identified with forward, starboard and
downward coordinates in this coordinate system.

The forward axis (X) must be parallel to the vessel keel, and the
downward axis (Z) must be vertical when the vessel is trimmed
normally. The plane defined by the forward and starboard axes
will then be horizontal, and the attitude sensor should then, if
properly installed and calibrated, measure zero roll and pitch
with a normally trimmed vessel lying still.
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• Forward position (X) - Forward position is defined on the
X-axis (refer to the illustration below). Locations further
forward than the reference point are positive.

• Downward position (Z) - Downward position is defined on
the Z-axis (refer to the illustration above). Locations below
the reference point are positive.

• Starboard position (Y) - If a sensor location is on the
starboard side of the reference point, the value will be
positive.

(CD3514C)
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Figure 7 Sensor
locations (example)

(1) Transducer (2) Motion sensor (3) GPS antenna
(4) Draught (5) Water line (R) Reference point

Procedure

1 Start the echo sounder, and make sure that normal
operation is activated (not Replay).

2 Open the Heave Sensor dialogue box from the
Installation menu.

3 Click the Sensor setup button, and observe the Sensor
Setup dialogue box appear.

4 Enter the coordinate values.

5 Click OK in both dialogue boxes to save the settings.

Related topics

→ Heave Sensor, page 111.

→ Sensor Setup, page 142.
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Sidescan

Overview
To use the Sidescan facility, you will need one or two extra
transducers. If dedicated sidescan transducers are mounted,
these must be installed facing sideways in a suitable angle. 120
and 200 kHz transducers have been specially designed for this
purpose.
With only a few simple commands, you will turn your EA 400
into a “side looking sonar”.

Figure 8 Typical dual sidescan view

Starting a sidescan survey
1 When starting a sidescan survey for the first time, both

transducers are presented in views tiled horizontally. Hide
the depth view of the lower sidescan display by moving
the horizontal boundary line downwards.

2 Hide the scope view of the upper sidescan echogram by
moving the vertical boundary towards right.
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3 In the upper echogram, click the right mouse button to
open the Echogram dialogue box.

4 Select Sidescan. The upper echogram will scroll
vertically.

5 Identify whether the upper sidescan echogram displays the
port or starboard transducer by selecting Port or
Starboard.

6 For a dual system, import the lower echogram into the
upper sidescan echogram. First select the second channel
from the drop-down menu, then click the Import box.

7 Click Ok. Both sidescan echograms will now show
side-by-side in the upper view.

8 In the upper echogram, click left mouse button over the
depth readout in the Header view to open the Bottom
detector dialogue box.

9 Set Maximum depth to zero, and click Ok.
10 Set Maximum depth to zero in the lower echogram as

well.
11 Hide the second channel in the lower view. Select Layout

in the View menu. Set up the echo sounder to allow only
the first sidescan channel to be shown, and click Ok.

If you do any other changes to the echo sounder parameters,
make sure that these parameters are set identical in both
echogram views. All changes made to parameters and views will
be stored when closing the EA 400.
You may wish to view the echograms using a grayscale
presentation, as this will enhance the sidescan view.

Insert label name
1 In the sidescan echogram, click the right mouse button

over the frequency in the Header view to open the
Transceiver Settings dialogue box.

2 In the Label field, enter a suitable description, and click
Ok.

Observe that the label is placed next to the frequency
information in the Header view.

Superimpose the current depth
If your echosounder is equipped with a third (or fourth) channel
and a transducer pointing straight down, you can superimpose
the current depth into the sidescan view.



Operational procedures

73857-160981 / J

1 Click the right mouse button in one of the two echograms
to open the Echogram dialogue box.

2 Enable Ext.depth (external depth), and select a transducer
frequency from the drop-down list.

3 Select Show annotation.
4 Click Ok.
Observe a red line appear on the echogram. The annotation lines
indicate the depth value. Additional in the header view, the
current depht is displayed in red (external depth).
You can also set up a third echogram channel to observe the
depth. This is done by selecting Layout on the View menu, and
then enabling a third channel.

Finishing the sidescan survey
1 In the top echogram, click the left mouse button to open

the Echogram dialogue box. De-select Sidescan, and
click OK.

2 Restore the other echo sounder setting to suit your
preferences.

Related topics

→ Echogram, page 100
→ Layout, page 118
→ Transceiver Settings, page 160
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REFERENCE GUIDE

Overview
This chapter describes the menus and dialogue boxes in detail.

Related topics

→ Echo sounder menus, page 75
→ Dialogue boxes, page 85
→ Status bar, page 83
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Menus

Main menu
The Main menu contains the following options:
→ File, page 76
→ View, page 77
→ Options, page 78
→ Interfaces, page 80
→ Install, page 81
→ Help, page 82
→ Status Bar, page 83

→ Step, described below.
Note that a number of dialogue boxes are accessed directly
using right-click on certain display fields.

Step!

In single-step mode you command the echo sounder to perform
one ping at a time by left-clicking the Step command. This
command does not activate any separate menus or dialogue
boxes.
You can also press Alt+S on the keyboard to make one ping.
See the Operation dialogue box for further details.

Related topics

→ Direct access to dialogue boxes, page 27
→ Operation, page 126
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File menu
The following commands are available on the File menu:
→ Operation, page 126
→ Store, page 148
→ Annotation, page 90
→ Print, page 129
→ Exit, page 76

Operation

This command option opens the Operation dialogue box. Use
these parameters to set echo sounder ping mode parameters;
normal/replay, ping interval etc.

Store

This command option opens the Store dialogue box. Use this
dialogue box to record data.

Annotation

This option opens the Annotation dialogue box. In this dialogue
box you can enter an annotation text message to be printed on
the echogram and/or saved to the current file.

Print

This command option opens the Printer and History dialogue
box. Use it to set printer parameters controlling echogram
printout on paper.

Exit

Select this command to terminate the echo sounder program.

Note You must always use this command before you turn off power!
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View menu
The View menu contains the following options:
→ Layout, page 118
→ History, page 114

Layout

This command opens the Layout dialogue box. Use it to modify
the layout of frequency channels on the display.

History

This command opens the History dialogue box. This is used to
activate a dialogue for viewing previously recorded echograms.
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Options menu

The following commands are available on the Options menu:

→ Language, page 117

→ Depth unit, see below

→ Temperature unit, see below

→ Palette, see below

→ Beeper, see below

→ Save settings, see below

→ Restore settings, see below

→ Factory Settings, page 109

→ Load User Settings, page 119

→ Store User Settings, page 152

→ Replay Control, page 138

→ Status Window, page 147

Language

This entry opens the Language dialogue box for language
selection.

Depth unit

All depth values are expressed in meters, English feet (1 ft =
0.3048 m), nautical fathoms (1 ftm = 1.852 m) or Italian Passi
Braccia (1 pb = 1.65 m). The Depth Unit entry activates a
submenu to select one of these alternatives.

Temperature unit

Water temperature is shown in degrees Celsius or degrees
Fahrenheit on the Status Bar. The Temperature Unit entry
activates a submenu to select one of the two alternatives.

Palette

Different light intensities on the display are provided according
to IMO (International Maritime Organisation)
recommendations. A bright display is required on a sunny
summer day, and a low light intensity is required at night in
order not to ruin the night vision of the crew at the bridge of the
vessel. The Palette entry activates a submenu to select the
display brightness.
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Beeper

This entry activates a submenu to control when the audible
warning signal is active to alert about status messages and
alarms. No dialogues are provided.

Save settings

The echo sounder memorises all its parameter settings between
power is turned off until it is turned on again at a later time. The
Save Settings entry writes a snapshot of all parameter settings
into static memory. No dialogues are provided.

Restore settings

This entry reads parameter settings from static memory into the
echo sounder application. No dialogues are provided.

Factory settings

This entry copies the default factory settings back into the
sounder. A proper clean-up of the complete menu system is
sometimes required in order to escape from unintentional
deadlocks. A dedicated dialogue box is used to acknowledge the
function.

Load user settings

This entry allows you to load your previously stored personal
settings. A dedicated dialogue box is provided.

Store user settings

This entry allows you to save your current settings to an
identified file on the computer harddisk. A dedicated dialogue
box is provided.

Replay control

This entry provides “cassette recorder” type control buttons to
be used during replay. It is also used to scroll and store new .raw
files.

Status window

This entry opens the Status Window, which provides current
information about the echo sounder settings.
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Interfaces menu
The following commands are available on the Interfaces menu:
→ Network Interface, page 123
→ Serial Interface, page 143
→ Remote Display, page 134
→ Raw Data, page 133

Network Interface

This command option opens the Network Interface dialogue
box. The parameters in this dialogue box are used to define the
network settings for the input and output of data.

Serial Interface

This command option opens the Serial Interface dialogue box.
The parameters in this dialogue box are used to define the serial
line settings for the input and output of data.

Remote Display

This command option opens the Remote Display dialogue box.
The parameters in this dialogue box are used to define the use of
a remote depth display.

Raw Data

This command option opens the Raw Data dialogue box. This
dialogue box is used to export raw data to a EA Classification
software.
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Install menu

The following commands are available on the Install menu:
→ Transceiver, page 158

→ Environment, page 105

→ Navigation, page 120

→ Heave, page 111

→ Temperature, page 157

→ Heading, page 110

→ SVP Dialog, page 155

Transceiver

This command opens the Transceiver Installation dialogue box.
Use this to install a new transceiver, and to assign a transducer
to each frequency channel.

Environment

Select this command to open the Environemnt dialogue box.
The settings here are used to select water salinity, sound velocity
and water temperature.

Navigation

This command opens the Navigation Interface dialogue box. In
this box, you can select communication parameters for the
NMEA interface, and select input/output telegrams.

Heave

This command opens the Heave Sensor dialogue box. It is used
to select heave input source; analogue or RS-232.

Temperature

This command option opens the Temperature Sensor dialogue
box.

Heading

This command opens the Heading dialogue box. It is used to
select a heading input telegram.

SVP Dialog

This command opens the svp dialoge box. It is used to select
realtime svp input telegram.
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Help menu
The Help menu contains the following options:
• Contents
• About the echo sounder

Contents

This command opens the on-line user manual. This user manual
is an HTML based document compiled to the CHM format
designed by Microsoftt.
The content of the on-line user manual is identical to the content
of the EA 400 Operator Manual.
The on-line manual is also accessed directly as context sensitive
help from the various dialogue boxes used throughout the echo
sounder software.

About the echo sounder

This command opens the About box. This box is for
information only. It provides the current software version and
the copyright information.
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Status Bar
The Status Bar displays status messages, event number, printer
active symbol, temperature, survey line number, navigational
data, time of day and ping replay timer.

(CD6744E / BM300D)
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The following information is provided on the Status bar:

1 Information - Various messages are displayed in this
field; warnings, status, information text.

2 Event - This field implements a push button for
generating an annotation of the event type. The event
number is automatically incremented or decremented by
one for each new event. The current event number is
displayed. An external Event toggle switch can also be
physically connected to the General Purpose Transceiver
(GPT).

3 Printer - A printer symbol is displayed whenever
echogram printing is active. Printing is delayed until the
echogram page has been completed.

4 Temperature - Water temperature is displayed in degrees
Celsius or in degrees Fahrenheit provided a temperature
sensor is connected to the system.

5 Line - This field acts as a toggle button. A left-click starts
the recording of a new survey line, and another left-click
terminates the recording of data. The survey line number
is automatically incremented (or decremented) by one
every second left-click. The current survey line number is
displayed on the button face. This line number is shown
with red colour during recording. The Line toggle button
can also be activated from a remote position if this
function was enabled during the installation.

6 History - This field is used to start and stop History
recording. Press the field to start recording History files,
and press again to stop,. The text is red when the
recording is active.

7 Navigational data - Geographical latitude and longitude
from the navigation receiver is displayed.
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8 Time - Local time of day is displayed. A small popup
window showing the current date appears when
positioning the cursor inside the time field. During replay,
this field is used as a timer.

Related topics

→ Recording procedure, page 60
→ Store, page 148
→ Print and History, pages 129
→ Print Setup, page 131
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Dialogue boxes

Introduction
The following chapters describe in detail all the dialogue boxes used in the EA 400
echo sounder. The dialogue boxes are presented in alphabetical order.

→ Advanced Navigation, page 86
→ Advanced Transceiver, page 88
→ Annotation, page 90
→ Bottom Detector, page 93
→ Bottom Range, page 95
→ Colour Scale, page 96
→ Depth Output, page 98
→ Echogram, page 100
→ Echogram Parameters, page 104
→ Environment, page 105
→ Exit, page 76
→ Factory Settings, page 109
→ Heading, page 110
→ Heave Sensor, page 111
→ History, page 114
→ IP Address, page 115
→ Language, page 117
→ Layout, page 118
→ Load User Settings, page 119
→ Navigation Interface, page 120
→ Network Interface, page 123
→ Operation, page 126
→ Printer and History, page 129
→ Print Setup, page 131
→ Raw Data, page 133
→ Remote Display, page 134
→ Replay, page 136
→ Replay control, page 138
→ Reprocess heave, page 139
→ RS-232 Setup, page 141
→ Sensor setup, page 142
→ Serial Interface, page 143
→ Sidescan Range, page 146

→ Status window, page 147
→ Store, page 148
→ Store user settings, page 152
→ Surface Range, page 154
→ SVP Editor, page 156
→ Real time SVP smart sensor, page 155
→ Temperature Sensor, page 157
→ Transceiver Installation, page 158
→ Transceiver Settings, page 160
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Advanced Navigation
The Advanced Navigation dialogue box is accessed from the
Navigation Interface dialogue box. The Navigation Interface
dialogue box is in turn available from the Install menu.

NMEA Position sentence

These boxes specify which type of NMEA navigation sentence
should be automatically interpreted.
If ASCII has been chosen in the Navigation Interface dialogue
box, these settings will be unavailable.

ASCII Setup

Use this protocol if you wish to receive data on ASCII format.
If NMEA has been chosen in the Navigation Interface
dialogue box, these settings will be unavailable.
Decoding is based on a user specified datagram identification.
The information substring within the datagram may be
identified by specifying the position of the start field, the
number of fields to be extracted and the field separator.
Start sequence - Maximum six characters used to identify the
type of input. The question marks are used as “wild card”
characters. You can enter any format you wish.
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No. of fields - Identify the total number of fields in the ASCII
message.
Start field - Identify which of the fields in the message is the
start field.
Field separator - Identify which ASCII character is used to
separate the fields in the message.
Terminator - Identify which character is used to terminate the
message.

Related topics

→ Navigation Interface, page 120
→ Data formats, page 189
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Advanced Transceiver

This dialogue box is accessed from the Transceiver Settings
dialogue box. It displays detailed numeric information
characterising the channel. This includes transducer parameters,
exact transmit frequency and receiver processing parameters.

Parameters

The parameters shown in this dialogue box are determined
during the transceiver installation procedure.

Frequency [Hz] - This is the nominal resonant frequency for
the transducer.

Beam type - Three different transducer beam types are
available: Single, Split and Triple. If your system is capable of
operating a Split- or Triple beam transducer, it will also be able
to measure the position of a target in the beam. The echo
sounder can then compensate for the known beam pattern to
obtain a true target strength.

Gain [dB] - The transducer gain presented by calculating the
directivity multiplied with the transducer’s efficiency. The value
is obtained during system calibration. If no calibration takes
place, the manufacturer’s default setting is used.

Two-way beam angle [dB] - This is a key transducer
parameter. The value describes the solid angle at the apex of the
ideal conical beam.

Sa Correction [dB] - This parameter is not shown on the EA
400.
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Absorption [dB/km] - This value describes the absorption of
sound in the water. The default values are computed according
to Francois and Garrison, Journal of Acoustic Society,
December 1982. The most important environmental variable
affecting this parameter is found in the Environment dialogue
box.
Bandwidth [Hz] - This is the resulting system bandwidth of the
analogue and digital filters in the echo sounder receiver. The
bandwidth is a function of the selected pulselength at a given
frequency.
Sound velocity [m/s] - The speed of the sound through the
water varies with temperature, salinity and pressure. The
soundings provided by the EA 400 are compensated for this.
Sample interval [m] - This value is always 1/4 of the current
pulse length. In distance, the sample interval will be expressed
as (sound velocity multiplied with pulse length) divided by
eight.
Angle sensitivity - In order to convert the raw angle samples
into mechanical degrees for fore-and-aft and athwartship
directions, this parameter is required. It represents the ratio of
electrical degrees to mechanical degrees for the current
transducer. This ratio is not used with single beam transducers,
and the value is set to 0.
3dB beam width [degrees] - This value presents the 3 dB
beamwidth of the current transducer in the fore-and-aft and
athwartship directions. The value is estimated during
calibration. If no calibration takes place, the default value is
used.
Angle offset [degrees] - This is the offset angle from the
acoustical axis. The value is estimated during calibration. If no
calibration takes place, the value 0 is used.

Related topics

→ Transceiver Settings, page 160.
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Annotation

The Annotation dialogue box is opened from the File menu.

The EA 400 echo sounder supports these different types of
annotation:

• Text - use this function to enter your own text.

• Time - use this annotation to automatically generate a time
marker at specified intervals.

• Event - use this annotation to generate an event number with
optional addition of time and/or navigation.

• External - this function allows automatic annotation from an
external source.

• Navigation string - this function will automatically generate
a text string with navigational information.

An annotation telegram is written into the replay data file and
the output data file. The annotation message is shown inside the
history window, on the echogram printout and on the screen if
Event is activated in the Echogram dialogue box.
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Text

The annotation text is entered here. Note that you need to have a
keyboard connected to the echo sounder. The text can be entered
freely, for example ”Dangerous wreck”. When you press the
OK button the text is written into the echogram. The next time
you open the Annotation dialogue box, the text is cleared, and
you must enter new information.

Time

Click Active to activate automatic time annotation. Enter the
desired time interval between the annotations. When activated,
the sounder automatically generates annotations containing the
current time at the chosen interval.

Event

Each event annotation is identified with an individual event
number. The event annotation is then generated every time an
event is generated. The event number is initially chosen here,
and thereafter automatically incremented or decremented every
time a new event is generated.

To generate an event, click Event in the Status bar.

The Event annotation can include current time and/or current
longitude and latitude. Click applicable Add Time or Add
Navigation to select. Without time or position data selected, the
annotation message will simply contain the event number.

Navigation string

Click Active to enable an automatic text string with navigational
information. The text string will appear on the display at every
’n’th telegram, as specified by the spin box.

Format:

Date / Position North / Position East

External events

External annotations may be input via the serial port for
navigation as an NMEA telegram, or using the Ethernet
interface with port 10183. The Annotation dialogue box does
not support direct control of these functions.

The Annotation telegrams are described in the Telegram
formats chapter.
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Events may also be generated from an external source by
toggling pin 9 on the Auxiliary connector on the General
Purpose Transceiver (GPT). This event will use the same
settings as for the Event toggle button on the Status bar.

Related topics

→ Status Bar, page 83
→ Echogram, page 100
→ Telegram formats; Annotation, page 192
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Bottom Detector

The Bottom Detector dialogue box is opened when you
right-click on the numeric depth value in the Header view on
the display.

This dialogue box is used to define the upper and lower depth
limits most likely to be used during the echo sounder operation.
These limits may be used to obtain ”bottom lock” on the depth
when the echo sounder is pinging. The sounder needs this lock
to locate the correct depth, and to stay on it during the
operation, even though the depth changes continuously.

The dialogue box is also used to set alarms to notify you if
maximum or minimum depths are exceeded.
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Parameters

Minimum Depth - The bottom detector starts the search for the
bottom echo at this depth. The detector will fail in shallow
water if you select a too large depth value, and the tail of the
transmitting pulse may cause problems if a too small value is
set.
Maximum Depth - The search for the bottom echo extends
down to this depth whenever bottom track is lost. Enter a
slightly larger depth value than the deepest spot you expect to
visit in order to avoid annoyingly long ping intervals every time
bottom track is lost. A depth value of either 0 or less than the
minimum depth disables the bottom detector.
Bottom Lost Warning - A warning is activated whenever
bottom track is lost. The warning is presented as a message in
the Status bar and as an audio signal.
Min. Depth Alarm - An alarm is activated whenever the
detected bottom depth is smaller than the chosen alarm
threshold. The warning is presented as a pop-up message and as
an audio signal. When the depth value is set to 0, this function is
disabled.
Max. Depth Alarm - An alarm is activated whenever the
detected bottom depth exceeds the alarm threshold The warning
is presented as a message on the display and as an audio signal.
When the depth value is set to 0, this function is disabled.
Backstep Min. Level - After the estimated depth of the bottom
detector, the detected depth is automatically adjusted by
stepping back according to the value of the setting you have
chosen. This allows the EA 400 to verify that the correct bottom
depth has been located. If the value you enter is too large (close
to 0 dB) the adjustments will be very small.
The default value is -40 dB.
Bottom Smoothing - If bottom track is lost, the detected
bottom depth is repeated for a maximum of three consecutive
pings.
Detect Second Layer Bottom - When in the Bottom Detector
dialogue for the lower frequency, select Detect Second Layer
Bottom and then choose the high frequency channel you want to
use as reference. This function is useful for detection of a
second (hard) layer. It is not to be used for hydrographic
surveying.
The Gain below reference depth is from the bottom detection
depth algorithm and is a linear gain function. The number given
is the increment in dB per meter
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Bottom Range

The Bottom Range dialogue box opens if you click the right
mouse button in the range field in the Echogram and Range
view while operating with a Bottom Range echogram.

The dialogue box will also open when selected in the
Echogram Parameters, Network Interface and Store dialogue
boxes.

The different echograms are explained in the Echogram
dialogue box.

Range - This parameter controls the vertical depth range across
the echogram.

Stop Relative Bottom - This parameter controls the depth offset
at the lower boundary of the echogram relative to the detected
bottom; positive values downwards.

Note that you can also change the range using the mouse wheel.
This is described in the Echo frames chapter.

Related topics

→ Echogram, page 100

→ Network Interface, page 123

→ Store, page 148
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Colour Scale

The Colour Scale dialogue box is opened when you right-click
on the colour scale in the Header view.

This dialogue controls the mapping of echo strength into one out
of 12 colours, light blue for weak signals and dark brown for
strong signals. Each discrete colour represents a 3 dB range of
echo signal strength implying that the next colour is selected
every time the echo strength doubles.

Parameters

A high numeric value displays weak echo signals properly while
the stronger signals saturate into dark brown colour. A low
numeric value displays strong echo signals properly. Weak
signals below the lower limit of the colour scale are not
displayed (the display background colour is used).

No TVG - This parameter controls the display sensitivity of the
echo sounder when No TVG is selected in the Echogram
dialogue box. A numeric value of 70 sets the lower limit of the
echogram colour scale equal to a measured input level of -70
dB.

20 log TVG - This parameter controls the display sensitivity of
the echo sounder when 20 log TVG is selected in the
Echogram dialogue box. A numeric value of 60 sets the lower
limit of the echogram colour scale equal to a volume
backscattering strength of -60 dB.

30 log TVG - This parameter controls the display sensitivity of
the echo sounder when 30 log TVG is selected in the
Echogram dialogue box. A numeric value of 30 sets the lower
limit of the echogram colour scale equal to a target strength of
-30 dB.
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40 log TVG - This parameter controls the display sensitivity of
the echo sounder when 40 log TVG is selected in the
Echogram dialogue box. A numeric value of 20 sets the lower
limit of the echogram colour scale equal to a target strength of
-20 dB.

Removing colours

By left-clicking on the colours in the colour rectangle in the
upper right-hand corner of the screen, the selected colour will
become the weakest colour shown in the Echogram view.
To restore the colour range, click on the removed colour’s
position.
Note that this is a display function only. It does not have any
effect on the sounder’s performance. It will however affect the
recordings made by the History function.

Related topics

→ Echogram, page 100
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Depth Output

The Depth Output dialogue box is called from the Heave
Sensor and Navigation Interface dialogue boxes. These are in
turn accessed from the Install menu.

It allows you to control the depth data output.

Parameters

Depth output - Check to enable the depth output.

Checksum - A checksum may optionally be appended to the
NMEA output telegrams (according to the NMEA standard).

Channel - NMEA depth telegrams are only output from one
channel at a time. Select channel from the list of installed
frequency channels.

Each entry in the list contains transceiver type, operating
frequency, unique identifier, channel number and transducer
type.

Telegram - The echo sounder can output three different types of
NMEA depth telegrams. However, only one telegram type at a
time can be generated. You can select the telegram type here.

• The $SDDBS telegram contains the depth below the surface.

• The $SDDBT telegram contains the depth below the
transducer.

• The $SDDPT telegram contains the depth below the
transducer and the distance between the transducer and the
waterline.

The EA 400 can also output the EA 500/EK500 compatible
depth telegrams; D1, D2 etc. Output for Atlas echo sounders are
also provided.
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More information about the NMEA datagrams can be found in
the Data formats chapter.

Related topics

→ Heace Sensor, page 111
→ Navigation Interface, page 120
→ NMEA datagrams, page 189
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Echogram

The Echogram dialogue box is opened by right-clicking on the
echogram in the Echogram and Range view on the display.
This dialogue is used to control the type and presentation of the
echograms.
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Echogram

Surface - Manual - The echogram is related to the sea surface.
Start depth (at the upper echogram boundary) and vertical range
(across the echogram) are manually selected in the Surface
Range dialogue box.
Surface - Auto Range - The echogram is related to the sea
surface. Start depth is manually selected in the Surface Range
dialogue box. The EA 400 performs automatic adjustment of the
vertical range keeping the bottom echo inside the visible
echogram.
Surface - Auto Start - The echogram is related to the sea
surface. Vertical range is manually selected in the Surface
Range dialogue box. The EA 400 performs automatic
adjustment of the start depth keeping the bottom echo inside the
visible echogram.
Bottom - The echogram is related to the detected bottom. Stop
depth (lower echogram boundary) and vertical range are
manually selected in the Bottom Range dialogue box. The
echogram is only drawn for pings having a successful bottom
detection.
Sidescan - Select to start the Sidescan option. If adequate
transducers have been installed, the echo sounder may be turned
into a “side looking sonar”. Normally the top echogram must be
activated with this setting, either when running single or dual
side looking. The echogram will scroll in its vertical direction.
Refer to the description in the Operational procedures chapter.
→ Sidescan procedure, page 71.

Sidescan

Port/starboard - Define if the current sidescan transducer is
mounted on the port or starboard side of the vessel.
Range view - The echogram will display both the water column
and the bottom. Valid for both single and dual systems.
Across view - If a vertical transducer is available, the bottom
echogram will expand (hiding the water column). The extent of
expansion (in metres) is set by the vertical depth. Valid for both
single and dual systems.
Import - It is possible to display both port and starboard
sidescan echograms in the same view. When opening the
echogram dialogue for one transducer channel, select the other
transducer channel to be imported in the drop-down list, then
click the Import box. This function is only valid for dual
systems.
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Horizontal Depth Lines

Scale - Equidistant horizontal scale lines are drawn inside the
echogram in the current foreground colour; black during day
and white during night. A maximum of 50 scale lines can be
drawn. No scale lines are drawn when the scale line count is set
to zero.
Show Annotation - A depth annotation will be written on each
horizontal scale line. The first annotation will appear on the
screen after a few seconds. The annotations are automatically
updated when you change the range, but they will only appear
on surface echograms.
Each echogram will be labeled with a number placed on the TX
pulse in each channel.

Show echograms - In mode 1x to 5x the centre echograms can
be chosen by selecting the transducer number in the waterfall
view. Example: If 3x is chosen and echogram 5 is centre, the
echograms 4 and 6 will be displayed in each side of echogram 5.
External depth - In the current echogram view it is possible to
show the bottom detection line for one of the other avaliable
echo sounder channels. A red line will represent the other
channel in this view. The depth value will also be displayed in
the Header view in red colour.
Bottom:
• On - The detected bottom depth is shown as a thin line in the

echogram. The line is drawn in the current foreground
colour; black during day and white during night.

• Off - The bottom line is switched off.
• White Line - A band in the current background colour is

drawn below the detected bottom depth.
• Contour Line - The echogram presentation normally shown

below the detected bottom will be inhibited, and only a white
space will remain.

Variable Depth - When enabled a horizontal depth line is
placed wherever you click in the Echogram view. The depth of
the line is displayed at the left end of it. In the History diagram
the depth for each ping is displayed individually.

Range other - Two horizontal lines indicate the range presented
in the lower echo frame.
Bottom Detection Lines - Two horizontal lines indicates the
minimum and the maximum bottom detection values and is
drawn with green colours.
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Vertical Markers

Event - A vertical line is drawn when a new event is generated.
Minute - A short vertical line is drawn in the upper part of the
echogram once every minute.
New Range - A vertical line is drawn when the range is
changed. The old range is written on the screen as an
annotation.
New Svp - A vertical line is drawn on the echogram when a
new sound velocity profile is applied. The value is written as an
annotation.

TVG

No - No TVG is applied. The echogram displays the input
power level at the transducer terminals. This echogram type is
used for test and research purposes.
20 log - 20 log TVG is applied. The echogram displays volume
backscattering strength and surface backscattering strength
below the detected bottom. This echogram type is suitable when
studying bottom properties.
30 log - 30 log TVG is applied. The echogram displays target
strength. This echogram type is suitable for special operations.
40 log - 40 log TVG is applied. The echogram displays target
strength and surface backscattering strength below the detected
bottom. For sidescan operation, this echogram type is suitable
when studying bottom properties.

Sub Bottom gain

From the bottom detection depth a linear gain function is
applied. The number given is the increment in dB per meter.

Ping Filter

The ping-to-ping filter ”cleans up” the echogram by removing
random noise spikes with no correlation with the previous ping.
The function will thus make echoes appear more stable.

Related topics

→ Surface Range, page 154
→ Bottom Range, page 95
→ Sidescan procedure, page 71.
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Echogram parameters
The Echogram Parameters dialogue box is opened by
left-clicking on Echogram Storage under the Interfaces menu.

Note This dialogue box is available for echo sounders with software
version up to 2.1.1.1.

This dialogue is used to control the datagrams exported by the
echo sounder on the serial lines.

Echogram data

38 kHz - Select which frequency channel to output echogram
data from. The channels installed on the echo sounder are listed
by frequency.
No.of Surface Values - The number of echogram samples to
export in the pelagic part of the datagram.
No.of Bottom Values - The number of echogram samples to
export in the bottom part of the echogram.
Surface Range - This dialogue sets up the limits for extraction
of echogram values for the surface part of the echogram. The
Surface Range dialogue box opens to allow the modifications.
Surface Range - This dialogue sets up the limits for extraction
of echogram values for the surface part of the echogram. The
Surface Range dialogue box opens to allow the modifications.

TVG

Select one of the three TVG settings for the exported data.

Related topics

→ Surface Range, page 154
→ Bottom Range, page 95
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Environment
The Environment dialogue box is available from the Install
menu.
Many other echo sounders are calibrated to a sound velocity of
1500 m/s. If the EA 400 is used together with other sounders it
is advantageous to adjust the sound velocity on the EA 400 as
well, in order to have the same depth readings.

Salinity

Propagation losses due to absorption are much higher in sea
water than in fresh water. Correct compensation for these losses
therefore relies on the echo sounder knowing which water type
is present.
Select Fresh or Salt water, enter the salt content as accurate as
possible.

Temperature

Propagation losses due to absorption depend on the water
temperature. Correct compensation for these losses therefore
relies on the echo sounder knowing which water temperature is
present.
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Select and define a constant temperature, or select temperature
reading from an external sensor. With an external sensor, the
reading will be continuously updated. The update rate is then
equal to the ping rate, and the reading in the dialogue box is
refreshed every two seconds.
The default sound velocity value is 1500 m/s, while the
temperature range is from -4 to +40_C.

Sound Velocity
For accurate measurement of depth the correct sound velocity
must be known by the echo sounder. The value can be entered as
a constant, taken from an ASVP file on the system, or received
on a serial or Ethernet line. The profile may be manually edited.
The value can be entered as a constant, or taken from a file on
the system. The file may initially contain profiles on
AMl-CALC, Kongsberg Maritime SSP10 or Simrad-A format.
Internally the sounder works with ASVP files. In other words,
the other formats is converted on input, and the file is stored
back as ASVP. A default file containing a constant 1500 m/s
profile is found in the folder c:\EA 400\data.
The sound velocity profile can also be modified during replay,
but only if the Change SVP Profile box in the Replay dialogue
has been checked before the replay commence.
Constant - Check this box to use a constant value, and select
the value in the spin box.
Salinity/Temp. - The salinity and temperature values currently
entered in the dialogue box is used to compute a sound velocity.
• If a constant temperature has been entered, the computation

will provide a fixed sound velocity profile.
• If temperature From sensor has been chosen, the sound

velocity profile will change automatically, but only with
temperature changes higher than 0,5°C.

Note that the computed sound velocity as applied as a constant.
This means that it will have the same value for the entire water
column.
From File - Check this box to retrieve the sound velocity
information from a file. Click the button on the right side to
open the file selection box.
Edit - Click to open the Sound Velocity Editor program.
To allow for serial or Ethernet input of the sound velocity
profile, you need to enable the interfaces. The serial line
interface is enabled using the Serial Interface dialogue box,
while the Ethernet input is enabled in the Network Interface
dialogue box.
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Unless otherwise defined, the received file(s) will be stored in
the following directory: c:\EA 400\data.
When a sound velocity profile is received by the EA 400, a
pop-up dialogue box will inform you. In this dialogue, you must
press Ok to use the profile as it is, or Edit if you wish to inspect
and/or edit it using the SVP Editor.

Related topics

→ Serial interface, page 143
→ Network Interface, page 123
→ SVP Editor, page 163
→ Replay, page 136
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Exit
The Exit command is available from the File menu.
Select this command to terminate the echo sounder program.

Note You must always use this command before you turn off power!

Related topics

→ File, page 76
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Factory settings
The Factory Settings dialogue box is accessed from the
Options menu. It does not provide specific parameters, but
simply allows you to acknowledge the chosen function.
Restoring factory settings is normally used only if you need to
restore the echo sounder after long time use, or if you have
made a number of incorrect selections in the menus or dialogue
boxes and wish to correct these fast.

When selected, this function will first stop the echo sounder
operation.
Second, all the personalized settings you have entered will be
removed. These include all the parameters you have chosen for
the operation, as well as changes you have made with the echo
sounder screen layout. The settings made for communication
(serial lines) and installation (transceivers and transducers) are
not affected. The only way to restore the operational settings is
to enter them all one more time.

Third, the echo sounder is restarted using the default settings
chosen by Kongsberg Maritime. These are considered generic,
and they are the same settings as when you first switched on the
echo sounder.
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Heading
The Heading dialogue box is accessed from the Install menu.
If you wish your echogram and detected bottom depth to be
heading corrected, you need to connect the EA 400 to a heading
sensor.

NMEA

HDT - Check this box to enable heading sensor datagrams in
HDT format.

Data Input

The most recent input data is displayed in a list. This function is
useful during installation and trouble shooting.
Clear - This button clears the input data list.

RS-232

This button activates the RS-232 Setup dialogue box. This box
is used to define communication port, baud rate etc.

Related topics

→ RS-232 Setup, page 141
→ NMEA data formats, page 174
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Heave Sensor

The Heave Sensor dialogue box is accessed from the Install
menu.

If you wish your echogram and detected bottom depth to be
heave corrected, you need to connect the EA 400 to a heave
sensor.

Source Selection

Off - Disregard all heave input.
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Analog - Heave sensors with analogue outputs are connected
directly to the Auxiliary Connector of the nearest General
Purpose Transceiver (GPT). Select the appropriate transceiver
from the list of installed transceivers. Each entry in the list
contains transceiver type, operating frequency and unique
identifier.
For each input, specific protocols may be chosen to accept
heave, pitch and roll input formats from various sensors.
Serial Line - Heave sensors with a serial line output are
connected to a RS-232 port at the rear of the echo sounder’s
processor unit.
Protocol - These options are only available when Serial Line
has been chosen. Use these to select serial line input format. The
echo sounder recognises one character based telegram
(Sounder/TSS1) and two binary telegrams (EM 1000 and EM
3000).
More information about the datagrams can be found in the Data
formats chapter.
Latency - Insert time for quoted accuracy (Ref. manual for
external sensor system and internal latency if known.)

Calculate remote heave

Click this function to enable the software to calculate the correct
heave. This calculation will include the heave values created by
the the roll and pitch movements. Note that the heave sensor
must have been properly positioned prior to this. Without this
selection, only the vertical transition values will be used.

Data Input

The most recent input data is displayed in a list. With analogue
input the input voltage and the computed heave value are
displayed. With serial line input the telegram content is
displayed. This function is useful during installation and trouble
shooting. The current heave value is displayed in meters in the
lower left corner of the dialogue box.
Clear - This button clears the input data list.
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Depth Output

This opens the Depth Output dialogue box.

RS-232

This button activates the RS-232 Setup dialogue box. This box
is used to define communication port, baud rate etc.

Sensor setup

This button opens the Sensor Setup dialogue box. This dialogue
is used to establish the relative position of the heave sensor. A
specific procedure is provided in the Operational procedures
chapter.

Related topics

→ Depth Output, page 98
→ RS-232 Setup, page 141
→ Sensor Setup, page 142
→ Positioning the heave sensor, page 69
→ NMEA data formats, page 174
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History

The History dialogue box is accessed from the View menu.

It displays echogram views previously saved during normal
echo sounder operation. This function greatly reduces the need
for echogram printout on paper. The presentation is made in a
separate window, and the echo sounder operates normally in the
background.

Echograms covering the past hours can be viewed by operating
the scroll bar at the bottom of the dialogue; the oldest echogram
view to the left, the newest echogram view to the right.

Click the button in the lower right corner if you wish to print the
current view. If you wish to print a series of echograms click the
button with the + sign.

The echograms stored in the history files are available on
*.BMP format on the harddisk. A directory for these were
created during the installation: c:\EA 400\history.

Recording, browsing and printing the history information is
described in the Operational procedures chapter. More detailed
information about the History window is provided in the
Display views chapter.

Related topics

→ Operation, page 126

→ History recording, page 63



Operator manual

115857-160981 / J

GPT IP Address
The IP Address dialogue box is used when you need to change
the echo sounder’s addressing.
Note that this operation is not required on a daily basis. You
only need to modify the address if your echo sounder system
shall be connected to an existing computer network on the
vessel. As long as the EA 400 operates as a stand-alone system
using the hardware supplied by Kongsberg Maritime, you will
not need to change anything.
To access this dialogue box, open the Transceiver Installation
dialogue box from the Install menu, select a transceiver, and
click Set new GPT IP Address. The echo sounder will stop
automatically.

If you need to change the address, keep 157 and 237 as the two
first bytes, as these are common for all Kongsberg Maritime
equipment. The two remaining digits can be chosen freely,
provided that no other Kongsberg Maritime equipment with the
same address is connected to the same network. Thus, if you
operate with more than one GPT, these must be set up with
different IP addresses.

Default factory address

First GPT: 157.237.15.99
Second GPT: 157.237.15.98
Computer: 157.237.16.12

Background theory

IP addresses are shown as four decimal integer numbers, where
each integer number corresponds to eight bits (or one byte) of
the address.
An IP address consists of a network address and a host address.
Three address classes are defined:
Class A used on large networks:
0NNNNNNN HHHHHHHH HHHHHHHH HHHHHHHH
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Class B used on medium size networks:
10NNNNNN NNNNNNNN HHHHHHHH HHHHHHHH
Class C used on small networks:
11NNNNNN NNNNNNNN NNNNNNNN HHHHHHHH
The address class is determined from the high-order bits of the
first byte.
• The first byte of a Class A address contains a zero and seven

network bits. The next 24 bites identify the host.
• A Class B address contains a one, a zero, 14 network bits and

16 host bits.
• Finally, a Class C address contains a one, a one, 22 network

bits and 8 host bits.
The echo sounder computer, GPT transceiver(s) and other
computers that communicate on the Ethernet must reside on the
same network. This requirement is met only if the host part of
the address differs.

Related topics

→ Transceiver Installation, page 158
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Language
The Language dialogue box is accessed from the Options
menu. Use this dialogue to select operational language.
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Layout
The Layout dialogue box is accessed from the View menu.
Installed frequency channels are visible on the display or
hidden. This dialogue box controls how many frequency
channels are visible and their layout on the display.

Arrangement

Visible frequency channels are vertically or horizontally
arranged on the display. Automatic selection of layout is also
provided.

Channels

The list of installed frequency channels is displayed; one
channel per line. Each entry contains a check box with the
operating frequency. Select visibility by checking the box.
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Load user settings
The Load user settings dialogue box is accessed from the
Options menu.

Use this dialogue to load previously saved settings.
To save settings, select Store User Settings on the Options
menu.
The information and current echo sounder settings stored with
this function are listed with the Store user setting dialogue box
description.

Related topics

→ Store User Settings, page 152
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Navigation Interface

The Navigation Interface dialogue box is accessed from the
Install menu.

A navigation receiver or other navigational instrument can be
connected to a RS-232 port of the EA 400 Processor Unit. The
input may be either standard NMEA datagrams or user specific
ASCII datagrams. Standard NMEA datagrams are automatically
interpreted, like the GGA and GLL navigation sentences.

Special $??ATS or CS datagrams (defined by Kongsberg
Maritime) may contain an external annotation message. See the
Annotation dialogue box for further information about
annotations.
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Position input

Source - Tick any of these three options to select the input
source for the position information. Selecting Off will disable
the input. If you select Serial, you must press the RS-232 button
to select input port. When Network is selected, you must open
the Network Interface dialogue box to define the local
computer port for the reception of the input data.
Protocol - Tick for the appropriate input protocol; ASCII or
NMEA. For setup of these protocols, see the Advanced
Navigation dialogue box.
Advanced - Click this button to open the Advanced
Navigation dialogue box. Use the settings in this dialogue to
change the navigational parameters.

Speed input

Use these parameters to specify the vessel’s speed.
Serial - to be used if navigational data is input on a serial line
from an external source into the EA 400. The current vessel
speed value is shown (when external speed input is selected).
Network - Select this option if you wish to retreive the speed
information from the network When this option is selectedyou
must open the Network Interface dialogue box to defined the
local computer port for reception of the input data.
The telegram format $--VTG,... is used.
Manual - only to be used if external speed data is unavailable or
unreliable.

Clock input (ZDA)

Use these parameters to set the clock.
Off - disables the input.
Serial - allows you to use navigational input on a serial line to
provide the clock. The current time is shown in the dialogue
box. The ZDA telegram format is used.
Network - provides clock input from devices on the network. In
order to set up this interface, the settings in the Network
Interface dialogue box must be used.
Automatic Set clock - When you tag this button, the echo
sounder will automatically synchronize the ZDA input clock
with the internal computer clock. If the difference of clock time
is more than 50 ms, the software will automatically do a clock
synchronization. All data files and time tagged output data will
use this new synchronized clock.
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Force Update - Same function as automatic set clock, but only
when button is activated.
Latency - Insert time for quoted accuracy (ref manual for
external position system and internal latency if known)

Data Input

Data Input - The most recent input data are displayed in a list.
This function is useful during installation and troubleshooting.
Clear - This button clears the list of input telegrams.
Note that no information is displayed when the network
interface (Ethernet) is used to accept the data.

Depth Output

This opens the Depth Output dialogue box.

RS-232

This button activates the RS-232 Setup dialogue box. This box
is used to define communication port, baud rate etc. The NMEA
standard specifies 4800 bits per second, 8 bits per character, 1
stop bit, no parity.

Related topics

→ Annotation, page 90
→ Advanced Navigation, page 86
→ Depth Output, page 98
→ RS-232, page 141
→ NMEA Datagrams: page 189
→ “$--VTG,...” telegram format, page 190
→ Network Interface, page 123.
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Network Interface

The Network Interface dialogue box is opened from the
Interfaces menu.

The dialogue box is used to:

• Identify the peripheral computer system the echo sounder
shall communicate with
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• Identify the local computer input port

• Define which datagrams the EA 400 shall export on the
network

Depth output

The depth information from the echo sounder can be exported
on two different formats; Simrad and NMEA. If required, both
formats can be exported simultaneously. Maximum four
frequency channels can be exported in Simrad format, while
only one channel can be exported in NMEA format. Those
channels installed on the echo sounder system are identified
with their respective frequencies. Channels not installed are not
selectable.

Tick the appropriate boxes to enable depth output on the two
formats.

Add Frequency – Draft and SVP

Tick the box if frequency, Draft and SVP information is needed
in the Simrad depth telegram.

Datagram output

Several datagrams may be exported from the echo sounder. Tick
the boxes to choose which of the datagrams to use.

Echogram data

Tick the applicable frequency box to enable echogram output on
the network interface.

TVG - Select the TVG setting for the echogram data.

No. of Surface Values - The number of echogram samples to
export in the pelagic part of the datagram (max 500!).

No. of Bottom Values - The number of echogram samples to
export in the bottom part of the echogram (max 200!).

Surface Range - This dialogue sets up the limits for extraction
of echogram values for the surface part of the echogram. The
Surface Range dialogue box opens to allow the modifications.

Bottom Range - This dialogue sets up the limits for extraction
of echogram values for the bottom part of the echogram. The
Bottom Range dialogue box opens to allow the modifications.
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Note For network output, the maximum number of samples is limited
to a total of 700 due to network protocol limitations.

If too many values are available for the given ranges a
decimation will take place. On the other hand, if too few values
are available in the given range compared to the wanted number
of samples, ”stretching” will occur. In this case sample values
are filled in to fulfill the demand for samples.

Remote computer

The settings here are used to identify an external computer on
the network to receive the datagrams exported by the echo
sounder.

Local computer input

This is the network port that the echo sounder will “listen” on
for reception of the different input datagrams.
On the EA 400 system, the port number must be set to 10183.
Correct IP address and port number on the remote computer
must also be provided.
The telegram formats accepted by the echo sounder is described
in the Telegram formats section.

Related topics

→ Datagram format descriptions, page 174
→ Surface Range, page 154
→ Bottom Range, page 95
→ Telegram formats, page 174
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Operation

The Operation dialogue box is accessed from the File menu.

This is the main dialogue box for operational control. You can
select operational mode and ping rate, and you can initiate
recording of the echo sounder information. The sounder has two
functions to greatly reduce the need for echogram printout
paper: Store/Replay and History.

The Store/Replay function records the unprocessed transceiver
data on the internal harddisk. These data are later injected into
the echo sounder processing software as if it arrived directly
from the transducer. When replaying the recorded signal, you
are free to experiment with the echo sounder settings.

This feature is useful during training and demonstration. It is
also useful for memorising a particularly interesting observation
from the survey.

The Store dialogue box is available from the File menu. The
Replay dialogue box is available from this dialogue box when
you click on the Files button.
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Recording the entire survey for later reprocessing is also
feasible provided you have a large enough harddisk. Replaying
the recorded signal is not limited by the speed of sound in
water. Hence, a higher ping rate is possible during replay than
during normal operation. The raw unprocessed transceiver data
are stored in standard computer files. These data files contain all
the necessary data for realistically reconstructing the situation
during the real survey; transceiver data, navigation data,
annotation input etc.
The History function is equivalent to the print function. The
echo sounder continuously saves echogram ”printouts” or
echogram pictures to the internal harddisk. These can later can
be recalled on the display.
The horizontal width of each echogram picture roughly
corresponds to the width of the display. The history function
allows you to quickly look through echogram pictures covering
the past hours.

Mode

The echo sounder either pings normally displaying the echo
signal received at the transducer, or it replays a previously
recorded echo signal stored in one of the four Raw Data
Memory locations.
Normal - Click the Normal button to enter Normal ping mode.
Replay - Select Replay for Replay (playback) mode.
Files - When selecting Replay mode, click the Files button to
activate the Replay dialogue to select the replay file.

External trigger

The Auxiliary connector on the General Purpose Transceiver
(GPT) includes a trigger input signal for transmit
synchronisation with external equipment. Normally, the EA 400
transmits as soon as it is ready for the next ping. Transmission is
delayed until a pulse is detected at the trigger input line when
the Extern Trig entry is checked.
Click this option to enable the EA 400 to work in Slave mode.
The echo sounder will then await the external trigger from the
peripheral system, and the transmissions from the systems will
be synchronized.
When this option is not checked, the EA 400 operates normally
as a Master system.
The external triggering system is explained in more detail in the
EA 400 instruction manual. Refer to the Cable layout chapter in
the printed book.
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Note External transmit synchronisation is only active in Normal ping
mode.

History

Echogram pictures are saved continuously to the harddisk when
the Save box is checked.
Synchronize with logfile - When this box is checked the
history file creation is synchronised with the survey log file
creation. When a new survey log file is started, a new history
log file is started, likewise when a survey log file is closed, the
current history log file is closed.
To select folder for the saved files, click Browse.

Ping rate

These settings are used to define how fast the echo sounder shall
transmit (“ping”). When the Maximum box is selected, the EA
400 transmits at maximum speed only limited by the speed of
sound in water and/or processing delays.
Selecting Single Step allows the EA 400 to conduct just one
ping cycle every time the Step! entry on the Main menu is
clicked, or the keyboard combination Alt+E is pressed.
Selecting Interval sets the echo sounder to transmit once at
every chosen time interval (in seconds).

Related topics

→ Store, page 148
→ Replay, page 136
→ Playback and recording procedure, page 60
→ History procedure, page 63
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Printer and History
The Printer and History dialogue box allows you to control
the output to the system’s colour printer.
The dialogue is accessed by the Print command on the File
menu.

Print

Check this box if you want the echogram printing to be active.
If the printer is switched on and active, a small printer symbol is
shown inside the Status bar.

Text to Printer

Status - Check this box if you want status messages to be
printed.
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Navigation - Check this box if you want position strings to be
printed. Navigation receivers typically output a new position fix
every second, and it is not practical to print them all on top of
the echogram. The count parameter in the spin box reduces the
rate of printing of the position strings. Every tenth position fix is
printed when this parameter is set to ten.
Annotation - Check this box if you want annotations to be
printed.
Scale annotation - The depth information will be printed on the
scale line. If the range is changed, the depth information will
automatically be updated when printing.
Sounder details - This function allows the most important echo
sounder parameters to be included on the print-out. This
includes for example current operational frequency, output
power, pulse length and TVG setting.

Text background

Click to select either opaque or transparent text background on
the annotation printouts.

Echogram speed

Select any of these values to slow down the printout relative to
the echo sounder speed. The ping rate will not be changed.

Print Setup

Click this button to access the Print Setup dialogue box.

Related topics

→ Annotations, page 90
→ Print Setup, page 131
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Print Setup
The Print Setup dialogue box is accessed from the Printer and
History dialogue box. Note that this dialogue box is a part of
the operating system, and the language displayed is that of the
operating system.
The EA 400 echo sounder uses the print mechanism of the
Microsoftt operating system when sending the echogram to a
printer. Virtually any modern printer can be used. This Print
Setup dialogue box controls the printing process. Installation of
a new printer is done with the operating system’s built-in
dialogue boxes. This is not described in this documentation.
Refer to the operating system’s documentation.

Printer

Name - This entry displays the logical name of the printer. A
typical EA 400 will normally have only one printer installed.
However, if you for some reason have more than one printer
installed, the Name box controls which printer to use.
Status - This field displays the status of the printer: ready, busy
etc.
Type - The type of printer is displayed.
Where - The name of the interface to the printer is displayed.
Comment - Any comment that was entered during the
installation of the printer appears here.
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Properties - This button activates the Properties dialogue box.
This is a printer specific dialogue for entering special purpose
printer parameters. You do not need to enter this dialogue box
during normal operation of the echo sounder. The Properties
dialogue box is part of the operating system. For further
information about this dialogue box, refer to the operating
system documentation.

Paper

Size - Modern printers support a variety of paper sizes.
However, the sizes A4 or Letter are appropriate when printing
echogram on paper.
Source - This setting tells advanced printers which paper tray to
use. The setting Automatic Select works on most printers.

Orientation

Select Portrait or Landscape. Landscape orientation is
recommended for echogram printing.

Network

This button activates the Network dialogue box. It is used to
send print jobs to a remote printer on a data network.
The Network dialogue box is part of the operating system. For
further information about this dialogue box, refer to the
operating system documentation.

Related topics

→ Printer and History, page 129
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Raw Data
The Raw Data dialogue box is accessed from the Interfaces
menu.

Output enable - If this output is actived (as shown), the raw
data is sent to the specified port and IP address.

Remote computer

These settings identify the remote computer.
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Remote Display

The Remote Display dialogue box is opened from the Install
menu. The dialogue box controls the data flow to an external
depth display (not a colour VGA display!)

Depth output

The depth information from the echo sounder can be exported to
a remote depth display. Use these settings to select which
information is exported, and on which format.

Output Enabled - Click to enable the output.

Format Selection - The remote display may be able to receive
the depth data on different formats. Two formats are provided;
RD1 and NMEA. Click to select the appropriate format. Note
that the RD1 format is only for the old Simrad RD display
using a proprietary format.

Channel selection - The remote display can only accept depth
data from one channel. Click here to select which channel to
export data from.

RS232

This button activates the RS-232 Setup dialogue box. This box
is used to define communication port, baud rate etc.
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Related topics

→ RS-232 Setup, page 141
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Replay

This Replay dialogue box is accessed from the Operation
dialogue box by clicking on the Files button. The Operation
dialogue is in turn opened on the File menu.

The Store function records the unprocessed transducer signal on
the internal harddisk or an other recordable media. The recorded
signal can later be injected into the echo sounder processing
software as if it arrived directly from the transceiver (Replay).

The Store dialogue box (also available from the File menu)
controls the recording of the unprocessed signal on the harddisk,
while this Replay dialogue controls the playback of this signal
into the echo sounder processing software.
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Survey (directory)

This is a standard file selector. Select survey directory first, and
then one or more files to be replayed.

Selected Files

The currently selected files are displayed in this field.

Loop

Check this box if you want the EA 400 program to loop through
the currently selected replay files without stopping.

Save Data

Check this box if you want to store processed output data. The
Store dialogue box will appear on the screen. The data can be
used by post-processing software when generating bottom
contour maps.
In this version it is not posible to store .out and .dg files to
harddisk.

Change SVP Profile

Check this box if you wish to apply a new SVP profile to the
data at hand. The Environment dialogue box will appear when
the box is checked.

Change Installation

This function allows you to replay one or all selected files with
different settings for draught and motion sensor location. You
can thus replay the file(s) without the heave information taken
into consideration. When you tick this box, the Reprocess
heave dialogue box will open automatically. Note that it will not
upen until after you click Ok in the Operation dialogue box.

Related topics

→ Store, page 148
→ Playback and recording procedure, page 60
→ Echogram parameters, page 104
→ Environment, page 105
→ Reprocess heave, page 139
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Replay control
The Replay control dialogue box is accessed from the Options
menu.

This small dialogue allows you easier access to the replay
function. The buttons work as follows:
Left arrow - Continuous playback.
Middle arrow - Stepped playback (ping by ping)
Right bars - Pause.
REC - Record. Use this button to record unprocessed transducer
data. This is a toggle button, and it is hence used both to start
and stop recording.
When starting a new recording, the file will be stored at the
same location on the hard disk as the original raw file. The file
name will be identical except that the time tag will be updated
and that an “R” will be added at the beginning of the file name.
→ An example is shown in the Replay dialogue, page 136

The recording process is indicated by the REC text turning red.

Timeline - The slider represents the timeline of the replay. To
start recording from a specific point in the replay, move the
slider as requested, then press the REC button. The time of start
will time-tag the stored file.
To close the dialogue, you must select Replay control once
more from the Options menu. Note that it is only available
during Replay mode.
It is also possible to close the dialogue using the exit button in
the top right corner.
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Reprocess heave
The Reprocess heave dialogue box appears automatically when
Change installation has been selected in the Replay dialogue
box, and then after you have exited the Operation dialogue.
The values initially shown in the dialogue box are those saved
with the original data file.

This dialogue box makes it possible for you to play back the
recorded echo sounder data using different sensor setup values.
The existing values will be shown when you access the
dialogue. You can then enter any values for draught and for the
physical position of the motion sensor for each frequency your
echo sounder has installed. All distances are in meters.
Note that changes made in this dialogue box will not be
reflected in the raw data files on the hard disk. These files will
not be changed.
Reprocess heave - Run the playback with the values currently
entered for x, y, z and draught. If you have manually changed
any of the veave or draught values, these modified values will
be used in the processing.
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Apply to all files - If you have selected more than one file in
the Replay dialogue box, the settings will be applied to all these
files, and the playback will run continuously. If you do not
check this box, the playback will stop for every new file, display
this dialogue box, and ask for new values. If any of the replay
files have been recorded with different transducers than what is
currently used, the playback will stop anyway.
Apply heave - This box must be checked to run the playback
with the initial heave values saved with the data file. If you
deselect this option, you will reprocess the data file with no
draught or heave values at all.
The use of the Reprocess heave function is related to the
Sensor setup dialogue box, which is initially used to establish
the relative position of the heave sensor with respect to the
vessel’s reference point.
Further description and a relevant procedure for this is provided
in the Operational procedures chapter.

Related topics

→ Operation, page 126
→ Replay, page 136
→ Procedure for sensor setup, page 69
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RS-232 Setup
The RS-232 Setup dialogue box is accessed from several other
dialogue boxes. It specifies the RS-232 communication settings.
Identical settings must be used at the opposite side of the
RS-232 cable.

Parameters

Port - Which RS-232 port do you want to use?
Baud Rate - Select communication rate.
Data Bits - Do you want to use 7 or 8 data bits per character?
Eight data bits per character are standard.
Stop Bits - One or two stop bits?
Parity - Do you want to use bit 8 for error checking?
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Sensor setup
The Sensor setup dialogue box is accessed from the Heave
sensor dialogue box. The Heave sensor dialogue is in turn
accessed from the Install menu.

The purpose of the Sensor setup dialogue box is to establish the
relative position of the heave sensor with respect to the vessel’s
reference point. If all the three values for X, Y and Z are set to
0, the motion sensor is physically located at the vessel’s
reference point.
Further description and a relevant procedure is provided in the
Operational procedures chapter.

Related topics

→ Heave sensor, page 111
→ Procedure, page 69
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Serial Interface

The Serial Interface dialogue box is opened from the
Interfaces menu. This dialogue is used to control the datagrams
and formats exported by the echo sounder on a serial line.

Depth Output

Maximum Data Output - Tick the box to enable maximum
data output on the serial line. When selecting a data output
frequency in the spin box, for example 20 Hz, depth data is then
output by 20 Hz independent of the ping rate.
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The depth information from the echo sounder can be exported
on three different formats; Simrad, NMEA and Atlas. If
required, all three formats can be exported simultanously.
NMEA - Tick the appropriate boxes to enable depth output
from one selected frequency channel. The available channels
will be listed.
Simrad - Tick the appropriate boxes to enable depth output on
Simrad ASCII format from selected frequency channels.
If Frequency, Draft and SVP information is needed in the
output, tick the box to enable the information.
HYMAS - Tick the appropriate box to enable all depths to be
output. Default 20 depth will be exported independent of
number of transducers/channels.
Atlas - Tick the appropriate boxes to enable depth output on
Atlas format from selected frequency channels. Note that the
Atlas format only supports two output strings. On a system with
more than two operational frequencies, only two of them can be
exported.

Datagram output

Several datagrams may be exported from the echo sounder. Tick
the boxes to choose which of the datagrams to use.

Datagram input

Tick to select the information to be imported on the serial line.
Annotation - This data will provide annotations on the
echograms. These annotations will appear on the display, in the
history files and on the printouts. Note that the Event vertical
marker must be enabled in the Echogram dialogue to display
the annotations. The $??ATS and CS datagrams are accepted.
Sound Velocity - This setting allows import of sound speed data
from an external sensor (computer). The accepted formats are
AML-CALC, Kongsberg Simrad SSP and Simrad-A.
Remote Control - This setting allows import of remote control
of logging and pinging on the serial input. The network is
automatically on, but the port must be entered as 10183. Storage
location must also be manually entered.

RS-232

This button activates the RS-232 Setup dialogue box. This box
is used to define communication port, baud rate etc. The NMEA
standard specifies 4800 bits per second, 8 bits per character, 1
stop bit, no parity.
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Related topics

→ Datagram formats, page 174
→ RS-232 Setup, page 141
→ Echogram, page 100



EA 400

146 857-160981 / J

Sidescan Range
The Sidescan Range dialogue box is opened by right-clicking
on the echogram in the Echogram and Range view on the
display (just below the Header view). This dialogue is used to
set the sidescan range (in metres) for both port and starboard
transducers.

The sidescan range can be set for both port and starboard
transducers in three different ways:
• By moving the slider
• By operating the arrows in the spin box
• By entering a range value directly in the text box

Related topics

→ Sidescan procedure, page 71.
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Status window
The Status window dialogue box is accessed from the pop-up
menu available in the Header view. Left-click in the Header to
view to open the short-cut menu, and select Status window.

This dialogue provides a quick overview of the current
parameter settings in the echo sounder.
To close the dialogue, click the small cross in the top right
corner.
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Store
The Store/Replay function records the unprocessed transceiver
data on the internal harddisk. The recorded signal can later be
injected into the echo sounder processing software as if it
arrived directly from the transducer.
The Store dialogue is accessed from the File menu. It controls
the recording of the unprocessed signal on the harddisk. The
Replay dialogue box (available from the Operation dialogue
box) controls the playback. The Store dialogue opens
automatically if enabling Save Data in the Replay dialogue
box.

Survey

Enter the complete path name of the survey directory. A new
directory is created if it does not exist. The new directory is
created when you click the OK button. Click the Browse button
if you wish to navigate through the disk directories.

Data formats

Save Raw Data - Check this box to save the unprocessed
transceiver data on the internal harddisk. The unprocessed
transceiver data is stored in standard computer files. These files
contain all the necessary data for realistically reconstructing the
situation during the real survey; transceiver data, navigation
data, annotation input etc. The echo sounder program reads
these files during replay.
Save Output Data - This field is used to save processed output
data on the internal harddisk (position fixes, bottom detections,
annotations). This data are used by the post-processing software
when generating bottom contour maps. Check the appropriate
box(es) to store all data in one file or to sort by frequency
(channels).
Save XYZ Data - This field is used to save xyz data on the
internal harddisk. These are interpolated values where x and y
represent position and z depth. Check the appropriate box(es) to
store all data in one file or to sort by frequency (channels).
Save Echogram Data - This field is used to save echogram
data. Check the appropriate box(es) to store all data in one file
or to sort by frequency (channels). Parameters for the data are
explained below.
Save Text Data - This field is used to save text data on the
internal hard-disk. These are complete raw position data and
depth data in ASCII format.
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More information about the file formats can be found in the
Data formats chapter.

Line No.

Enter the initial survey line number. A toggle button inside the
Status bar on the display controls the start and stop of each
survey line. The line number is automatically incremented (or
decremented) by one for every new survey line. Click the box
and local time will be used in the file names, otherwise GMT is
used.
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A new line number can also be initiated from an external button
connected to the General Purpose Transceiver (GPT) if this has
been implemented during system installation.
Sare GeoRef Data - This field is used to save GeoRef data on
the internal hard-disk. These data can consist of two different
formats: SSG and VGR. SSG is for side scan geoRef data and
VGR is for vertical geoRef data.

Echogram Data

Tick the appropriate boxes to save echogram data. The
parameters provided are identical to those in the Echogram
Parameters dialogue box.
Channel - Select which frequency channel to output echogram
data from. The channels installed on the echo sounder are listed
by frequency.
No.of Surface Values - The number of echogram samples to
export in the pelagic part of the datagram.
No.of Bottom Values - The number of echogram samples to
export in the bottom part of the echogram.
Surface Range - This dialogue sets up the limits for extraction
of echogram values for the surface part of the echogram. The
Surface Range dialogue box opens to allow the modifications.
Bottom Range - This dialogue sets up the limits for extraction
of echogram values for the bottom part of the echogram. The
Bottom Range dialogue box opens to allow the modifications.
TVG - Select one of the three TVG settings for the exported
data.

Max File Size

Enter the maximum size of each replay file. The replay file
contains the unprocessed transceiver data. Several kilobytes of
sample data is written into this file every ping. All sample data
may be contained in just one file for short survey lines.
However, the amount of data grows rapidly as the survey lines
become longer, and it may be necessary to split the data into
fragments which are stored in sequential replay files.

Related topics

→ Operation, page 126
→ Replay, page 136
→ Playback and recording procedure, page 60
→ Size control, page 61
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→ Data formats, page 189
→ Echogram Parameters, page 104
→ Surface Range, page 154
→ Bottom Range, page 95
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Store user settings
The Store user settings dialogue box is accessed from the
Options menu.

Use this dialogue to save your current settings. Fill in your name
or initials in the Create user field, and press the New user
button to create a new directory for the information. You can
easily store different personal settings if so desired.
The following information and current echo sounder settings
can be stored and retrieved using this functionality:
• Transmit power
• Pulse length
• Lable
• Echogram view
• Bottom detector settings
• Range settings
• Colour settings
• Operational settings in the Operation dialogue box.
• Transceiver Installation (for example starbord transducer(s),

port transcucer(s) or both (all) transducers).
To load the settings, select Load user settings from the Options
menu.
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Related topics

→ Load User Settings, page 119
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Surface Range
The Surface Range dialogue box opens if you click the right
mouse button in the range field in the Echogram and Range
view while operating with a Surface Range echogram.
The dialogue box will also open when selected in the
Echogram Parameters, Network Interface or Store dialogue
boxes.
The different echograms are explained in the Echogram
dialogue box.

Parameters
Range - This parameter controls the vertical depth range across
the echogram.
Start Relative Surface - This parameter controls the depth at
the upper boundary of the echogram, relative the transducer
face.
Note that you can also change the range using the mouse wheel.
This is described in the Echo frames chapter.

Related topics
→ Echogram, page 100
→ Network Interface, page 123
→ Store, page 148
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Real time Sound Velocity Profile (SVP)
smart sensor
This SVP dialogue box is opened from the Install menu. The
dialogue box controls and store the data from the SVP smart
sensor in real time. The real time reading is only for SVP smart
sensor from Applied Microsystems Limited.

• Init Probe: This button start reading the sensor. Data will
appear in the window after few seconds.

• Start Log: Start logging data to the harddisk. Default EA
MCU32/data.

• Stop log: Stop logging data to the harddisk and close the file.
Example of SVP file name: 20060508_144907.asvp

• Decimate SVP data: The input data will be decimated after
following formula. ΔD > 0.2 m and Δs > 0.5 m/s.

After stopped logging of SVP data, click button “OK”. New
dialogue box will appear. Answer YES if you want to use the
new profile or NO for using existing sound velocity.

Related topics

→ Envionment page 105
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Sound Velocity Profile (SVP) Editor
The SVP Editor dialogue box is accessed from the
Environment dialogue box.

The SVP Editor is regarded as a separate program, and it is
described in a dedicated chapter.

Related topics

→ SVP Editor description, 164
→ SVP Editor operation, page 167
→ SVP Editor reference information, page 170
→ Environment, page 105
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Temperature Sensor
The Temperature Sensor dialogue box is accessed from the
Install menu. Water temperature is shown on the echo sounder
display provided a thermistor (temperature sensitive resistor, 10
kohm at 25 deg C) is interfaced to the system.
The thermistor wires are connected directly to the Auxiliary
connector of the nearest transceiver.
The water temperature can be exported on NMEA format
(MTW) on both the serial and Ethernet interfaces.

Analog Input - Select the appropriate transceiver from the list
of installed transceivers. Each entry in the list contains
transceiver type, operating frequency, unique identifier, channel
number and transducer type. The GPT uses its Ethernet address
for unique identification.
Data Input - The most recent input data are displayed in a list.
Measured thermistor resistance and the computed temperature
value are displayed. This function is useful during installation
and troubleshooting.
Clear - This button clears the input data list.
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Transceiver Installation
This dialogue box controls installation and un-installation of
transceivers. The dialogue box is accessed from the Install
menu. Prior to this, all echo sounder activity must be stopped.
When accessed, an opening dialogue allows you to either:
• Inspect the transceiver installations

• Modify the transceiver installations
• Cancel the operation

Every time the Transceiver Installation dialogue appears on
the display the echo sounder software performs a search for
transceivers. General Purpose Transceivers (GPT) connected to
the Ethernet interface are identified automatically before the
complete transceiver list is displayed.

Transceiver list

A single frequency transceiver occupies one entry in the list, and
a dual frequency transceiver occupies two. Each entry contains:

• Transceiver type
• Operating frequency

• Unique identifier

• Frequency channel number

• Transducer type
The General Purpose Transceivers use their Ethernet addresses
for unique identification.
The frequency channel number identifies individual channels
within a multi-frequency channel transceiver.
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Frequency channels

Hence, the echo sounder system consists of a number of
frequency channels. Entries in the frequency channel list are
shown in black, green or red colour. Detected channels that are
not installed are shown in black. The phrase NONE replaces the
transducer type name for uninstalled channels. Detected
channels that are installed are shown in green colour. Installed
channels that were not detected during the search for
transceivers are shown in red colour.
Each entry in the Frequency Channel Selection list belongs to
a transceiver. The lower part of this dialogue box displays
information about the currently selected transceiver. The first
information line displays the transceiver personality string.
Remaining lines display specific transceiver information.

Set new GPT IP Address

The communication on the Ethernet network between the echo
sounder computer and the General Purpose Transceiver(s)
complies to the TCP/IP (Transport Control Protocol / Internet
Protocol) family of protocols. Every host (GPT or computer)
connected to the network must have a unique 32-bit IP address.
To modify the GPT IP address, refer to the IP Address dialogue
box.

Related topics

→ To install or uninstall a channel, page 58
→ To modify an IP Address, page 59
→ IP Address, page 115
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Transceiver Settings

The Transceiver Settings dialogue box is accessed from the
Header view on the display. Place the cursor on top of the mode
and frequency information, and press the right mouse button.

This dialogue box controls transceiver and transducer
parameters specific to the current frequency channel.

A text line at the top of the dialogue box identifies the
frequency channel. This identification line contains:

• Transceiver type

• Operating frequency

• Unique identifier

• Channel number

• Transducer type

The channel number identifies individual channels within a
multi-frequency channel transceiver.

A second text line appears in replay mode. This identifies the
name of the replay file.
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Mode

Active - The transmitter and receiver are active (normal
operation).
Passive - The transmitter is passive while the receiver is active.
This mode of operation is useful for test purposes, and when
you wish to measure the ambient background noise in the sea.
Test - The transmitter is passive and the receiver is active. Each
General Purpose Transceiver board includes a signal generator
injecting a weak test signal (-70.0 dBW) into the receiver’s
input circuitry. The nominal power reading at the display is
-70.0 dBW for channels using one transceiver board (1 or 2
kW).

Label

This function allows you to enter a text string to appear on the
right hand side of the current frequency in the Header view.

Transmit Power

This parameter controls the transmitter’s output power. Output
power is limited either to the maximum rating of the transducer,
or the maximum rating of the transmitter, whichever is the
smallest.

Pulse Length

This parameter controls the duration of the transmit pulse.
The table below shows the pulse lengths (given in μS) available
for the different operational frequencies.

-- 64 128 256 512 1024 2048 4096 8192 16384

38 kHz -- -- X X X X X -- --

50 kHz -- X X X X X -- -- --

70 kHz -- X X X X X -- -- --

120 kHz X X X X X -- -- -- --

200 kHz X X X X X -- -- -- --

710 kHz X X X X X X -- -- --

Table 1 X-axis is pulse length in μS, Y-axis is frequency in kHz.
“x” means that the pulse length is available for the given frequency.

Transducer

Type - The transducer currently connected to the transceiver is
identified.



EA 400

162 857-160981 / J

Draft - In order to measure correct water depth, the echo
sounder needs to know the vertical distance between the vessel’s
water line and the transducer face. Here, enter the depth of the
transducer face relative the waterline.
Transducer parameters - The x, y and z parameters are
relative positions between the defined reference point and the
transducer. Parameters to Zero (default) will ignore the input
values from the attitude sensor.
Real time draft - This parameter shows the real time value
from the sensor and will be updated according to the sensor
dataputput..

Advanced

This button opens up the Advanced Transceiver dialogue box
containing detailed numeric information about the transducer
and the channel.

Related topics

→ Advanced Transceiver, page 88
→ Heave Sensor, page 111
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SVP EDITOR

Introduction
This chapter describes the SVP Editor (Sound Velocity Profile
Editor).

Related topics

→ Description, page 164
→ Procedures, page 167
→ References, page 171
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Description

Purpose
The purpose of the Sound Velocity Profile Editor is to:
• edit or inspect existing sound velocity profiles
• create a new profile
How to start the editor is explained in the operational
procedures.
The editor contains the following elements:
(1) Toolbar
(2) Profile view
(3) Data view
(4) Filename
(5) Control bar
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Toolbar
This area contains several buttons for editing a profile.
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From top, the buttons are:

1) Delete

2) Move

3) Add

4) Zoom

5) Pan

6) Zoom to contents

7) Undo

8) Extend profile

9) Sort

The buttons are explained in the References chapter.

Profile view

This is the large area at the middle of the window. It has two
axes:

• Sound velocity: horizontal axis along the upper edge.

• Depth: vertical axis on the left hand side.

Each profile is a sequence of points. These have coordinates
with increasing depth values. Straight lines connect the points.
The points are emphasised as bullets on the curve.

Data view

This area has two columns. One contains the depth values, and
the other one contains the sound velocity values. There is one
depth value, and one sound velocity value for each point.

Profile name

The name of the profile is shown in this window.

Control bar

At the bottom of the editor there are four buttons. These are the
Save, SaveAs, Close and Help button. The buttons are
explained in the References chapter.
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File formats
The editor operates on files, and accept the following file
formats:
• Simrad-A
• AML-CALC
• Kongsberg SSP10

Related topics

→ Procedures, page 167
→ References, page 171
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Procedures

Windows
The Sound Velocity Profile Editor operates with a single
window. This window is referred to as the main window in this
document. In this window, you can view the sound velocity
profile.

Starting the editor
The editor is started as follows:
1 Select Install on the main menu bar.
2 Select Environment on the drop-down menu.

- The Environment dialogue box appears.
3 To open a profile, choose From File.
4 Choose which file to edit.

- The name of the last edited profile is displayed. If you
wish to edit a different profile, click From File, choose
the new file , and press Open.

5 Click the Edit button in the Environment dialogue box.

Exit
The editor is closed as follows:
1 Push the Close button on the bottom of the editor.
This will close the application without saving. There will be no
warning about unsaved material.

Open existing profile
It is not possible to open an existing profile from within the
editor. You must select a profile before you open the Sound
Velocity Editor.

Create new profile
You cannot open the Sound Velocity Editor without using an old
profile. Therefore you must:
1 Open an old file.
2 Make the necessary changes.
3 Use the Save As button, and save it with a new profile

name.
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Or:
1 Open an old file.
2 Use the Save As button, and save it with a new profile

name.
3 Make the necessary changes.
4 Use the Save button.

Save profile
You can save a profile in the following manner:
If you have already named the profile:
1 Click the Save button on the bottom of the editor.

- This automatically saves the profile.
If you want to rename the profile:
1 Click the Save As button on the bottom of the editor.
2 Choose where to save the profile, and give it a name.

Remember to provide it the correct file extension.
3 Click OK to save.

Modifying a profile

Move point

1 Select the Move button on the toolbar (second from top).
2 Place the mouse pointer on the point you want to move.

Press the left mouse button and keep it pressed.
3 Drag the point to the new position.
4 Release the mouse button when the new location is

reached.

Add point

1 Select the Add button on the toolbar (third from top).
2 Place the mouse pointer where you want to add the point,

and click once with the left mouse button.
When you have added a point the curve will follow
automatically, and include the new point.

Remove point

1 Select the Delete button (first from top).
2 Choose the point you want to delete and click on it once

using the left mouse button.
The point is immediately deleted, and the profile will be
redrawn without it.
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Adjust the velocity or depth

1 Select the Move button on the toolbar (second from top).
2 Select the point you want to adjust, by using the left

mouse button. Press the button and keep it pressed.
3 Drag it to the depth and/or the velocity you want.
4 Release the button.
Or:
1 Go to the Data view and select the point you want to edit,

using the right mouse button.
2 Choose Edit from the menu.
3 Do the changes you want to do, by changing depth and/or

velocity.
4 Press OK.

Zoom and pan

Zoom

1 Select the Zoom button on the toolbar.
2 Click on the left mouse button and keep it pressed.
3 Drag the mouse so that it covers the area you want to

enlarge.
4 Release the mouse button.

Pan function

This button is used to “move” what you see in the Profile view.
When you press down the left mouse button, you have to hold it
in while moving it around.
1 Select the Pan button on the toolbar.
2 Click on the left mouse button and keep it pressed.
3 Drag the mouse and move it to the position you want.
4 Release the mouse button.

Zoom to contents

1 Click on the button that is number four from the bottom
on the toolbar to the left. (Button is shown in the figure
below).

Related topics

→ Environment, page 105
→ References, page 171
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References

Note Each function is active until another function is selected.

Toolbar, left
This area contains several buttons for editing a profile.

Delete

This button selects the delete function. Click once. Then click
on each point to be deleted. As long as the Delete button is
active, you can delete points by clicking on them.

Move

This button selects the move function. Click once. Then select
the point to be moved. Click on it and hold it in while you move
it to the desired position. Then release the button. You can move
points as long as the Move button is active.

Add

This button select the add function. You can click anywhere in
the Profile view, and a new point is added. The curve will
follow immediately . You can add points as long as the Add
button is active.

Zoom

This button selects the zoom function in the Edit area. The
diagram is brought “closer” to you, and because of this, the
parts near the edges disappear from the view. You can enlarge
the diagram with this zoom-buttom X times.
To mark an area, press down the left mouse button while
dragging. When this field covers the area you want to enlarge,
drop the button.

Pan

This makes the profile “move”, and you get to see other parts of
the profile. Click somewhere in the profile area, and drag the
mouse. The point you selected, will follow the mouse until you
drop it.

Zoom to contents

If you want to view all the points at the same time, i.e. you want
to look at the entire profile, you can use this button.
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Undo

This button is used to undo the last action made. If you wish to
undo more than the last action, press the button as many times
as desired.

Extend profile

There is an already existing “profile” that is used to fill out the
rest of your profile, down to 12000 meters. This profile has
been made especially for the Atlantic ocean, but can be used in
similar waters. If you have made your own profile down to for
example 2000 meters, you can use this button and you will
extend the rest of the profile automatically.

Sort

This button is used to sort the points in ascending order. If you
have moved points so that someone is “higher” than others, use
this button to update the curve. The curve will be automatically
updated.

Toolbar, bottom

Save

The editor will use the old profile name when you use the Save
button.

SaveAs

When you click on the SaveAs button, you will see a standard
save-window. This means that you can choose where to save the
profile, and give the profile a new name. Click OK when
finished.

Close

This closes the profile. It will not give any warnings about
unsaved material.

Help

This brings you to the online help.
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EA2NEPTUNE

Introduction
The EA2Neptune is a small software utility designed to
reformat EA 400 *.out data files to the *.ea format used by the
Neptune post-processing suite.
To investigate the software version, rightclick in the blue title
bar, and select About.

Use
1 Start the EA2Neptune utility directly from the computer’s

EA 400 directory..
a Press the Start button in the lower left corner, and

select Run on the menu.
b Enter the phrase C:\EA 400\ea2neptune.exe in the

Open field, and press Ok. (Replace ”C” if the EA 400
is installed on a different drive.)

2 Select which datagrams to convert.
3 Press the Select files button to open the Convert dialogue

box.
4 Choose the *.out files to be converted.

- More than one file can be selected simultanously
5 Press Open to close the Convert dialogue box.
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The convertion takes place automatically once the Convert
dialogue box is closed. The *.ea files are placed in the same
directory as the input *.out files.

Datagrams description
The datagrams you can convert from are described in the
Telegram and data formats chapter.
For detailed information about the Neptune datagram formats,
refer to the Neptune operator manual.

Related topics

→ Telegram and data formats, page 183
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TELEGRAM AND DATA FORMATS

Overview
This chapter describes the external interfaces supported by the
EA 400 echo sounder. The information includes information
about the file formats used, as well as the telegram formats used
to communicate with external peripherals and other computer
systems.

General information

→ Numeric presentation, page 175

File formats

These chapters provide information about the various file
formats used to store and communicate EA 400 data.
→ Data encapsulation, page 176
→ File and directory names, page 177
→ Raw data file, page 179
→ Out data file, page 183
→ xyz data file, page 186
→ Text data file, page 186
→ GeoRef data file, page 186
→ Echogram data file, page 188

Datagram formats

These chapters provide information about the datagrams formats
used to communicate echo sounder data to and from the EA 400
system.
→ NMEA datagram, page 189
→ Annotation datagram, page 192
→ Remote Control datagram, page 193
→ Depth datagrams, page 195
→ Echogram datagrams, page 200
→ Status datagrams, page 201
→ Georef Output datagram, page 202
→ Navigation Output datagram, page 204
→ Motion Sensor datagram, page 205
→ Sound Speed datagram, page 206
→ Attitude datagrams, page 211
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Numeric presentation
In order to describe the file formats, common “C” structures are
used to represent individual data blocks. The size of the various
C types are:
• char: 8 bit integer
• short: 16 bit integer
• long: 32 bit integer
• float: 32 floating point (IEEE 754)
The native numeric representation of common computer types is
shown in the table below.

Make Byte order Floating point format

IBM PC (Intel) Little Endian IEEE 754

Sun (Sparc) Big Endian IEEE 754

HP (PA) Big Endian IEEE 754

Silicon Graphics (MIPS) Big Endian IEEE 754

DEC (Alpha) Little or Big Endian IEEE 754 or VAX

Power PC (MPC) Little or Big Endian IEEE 754
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Data encapsulation
A standard encapsulation scheme is used for all data files. Each
datagram is preceded by a 4 byte length tag stating the datagram
length in bytes. An identical length tag is appended at the end of
the datagram.
long Length;
struct DatagramHeader
{

long DatagramType;
struct {

long LowDateTime;
long HighDateTime;

} DateTime;
};
- -
< datagram content >
- -
long Length;

All datagrams use the same header. The datagram type field
identifies the type of datagram. ASCII quadruples are used to
ease human interpretation and long term maintenance; three
characters identify the datagram type and one character
identifies the version of the datagram. The DateTime structure
contains a 64-bit integer value stating the number of
100-nanosecond intervals since January 1, 1601. This is the
internal ”filetime” used by the Windows NT operating system.
The data part of the datagram contains any number of bytes, and
its content is highly datagram dependent.
Common computers fall into two categories: Intel based
computers write a multibyte number to file starting with the
LSB (Least Significant Byte). HP, Sun and Motorola do the
opposite. They write the MSB (Most Significant Byte) to file
first. The byte order of the length tags and all binary fields
within a datagram is always identical to the native byte order of
the computer that writes the data file. It is the responsibility of
the software that reads the file to perform byte swapping of all
multibyte numbers within a datagram if required. Byte
swapping is required whenever there is an apparent mismatch
between the head and the tail length tags. Hence, the two length
tags may be used to identify the byte order of the complete
datagram.
The Intel processors allow a multibyte number to be located at
any RAM address. However, this may be different on other
processors; a short (2 byte) must be located at an even address, a
long (4 byte) and a float (4 byte) must be located at addresses
dividable by four. Hence, the numeric fields within a datagram
is specified with this in mind.
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File and directory names

File names

The echo sounder uses the standard Windows NT file system.
Sample data, transceiver data etc. may be recorded in a *.raw
file for later replay through the sounder. Processed output data
may be stored in a separate *.out file. ASCII data, as xyz data,
may be stored in a separate *.xyz file.
As an example, we will assume that we are conducting a
hydrographic survey on Loch Ness. The following files are
generated by the sounder during the survey:
..\LochNess\L0000-D19990821-T101354-EA 400.raw
..\LochNess\L0000-D19990821-T102114-EA 400.raw
..\LochNess\L0000-D19990821-T103255-EA 400.raw

..\LochNess\L0000-D19990821-T101354-EA 400.out

..\LochNess\L0001-D19990821-T105209-EA 400.out

..\LochNess\L0002-D19990821-T112021-EA 400.out

..\LochNess\L0002-D19990821-T112021-EA 400.xyz

..\LochNess\L0002-D19990821-T112021-EA 400.dg.

Directory
All the files reside in the ”survey directory”. The name and
location of this directory (henceforth the Survey Name) is
assigned by you. It typically states the survey area or the
purpose of the survey. The file name consists of:
• a transect pre-fix (Lxxxx)
• the date (YYYYMMDD)
• the time (HHMMSS)
• instrument identifier
• file type extension
The transect pre-fix states the current transect line number, and
a new file is opened for every new line. The transect pre-fix is
generated by the EA 400 sounder. Please note that other
Kongsberg Maritime sounders might use a different transect
pre-fix.

Raw data file

The *.raw file is by far the largest of the two file types. All
necessary data to perform a complete replay of the survey, is
written into this file. For a very short transect line, all sample
data may be contained in one file. However, the amount of data
grows rapidly as the transect lines become longer. It is therefore
practical to split the data into fragments which are stored in
sequential files, each fragment containing a user specified
amount of data.
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Out data file

The *.out files contain less amount of data. Fragmentation is
supported, but is normally not required. Typically, this file
contains navigation data and bottom detections that may be used
by post-processing software.

xyz data file

The *.xyz files contain position (Lat/Lon) and depth
information in ASCII format. These files can be used by third
party post-processing software.
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Raw data format

Overview

Note The described file format is a temporary format, valid for data
files recorded with the software version 1.4. This file format is
expected to change in future EA 400 versions and Kongsberg
Maritime assumes no responsibilty for support on this format.

The *.raw file may contain one or more of the following
datagram types:
• CON0 - Echo sounder configuration datagram
• NMEA - Navigation input text datagram
• TAG0 - Annotation datagram
• RAW0 - Sample datagram
Every *.raw file begins with a configuration telegram. A second
configuration datagram, within the file, is illegal. The data
content of the configuration datagram of an already existing file
cannot be altered from the echo sounder. NMEA, annotation and
sample datagrams constitute the remaining file content. These
datagrams are written to the *.raw file in the order that they are
generated by the sounder.
Note that the information following the “//” sign are comments
to that line.

Note Strictly sequential time tags are not guaranteed.

Echo sounder configuration datagram

The echo sounder uses this datagram when creating channels
during replay. All character strings are zero terminated.

char SounderType[128]; // ”EA400 3.17”

struct ConfigurationDatagram {
DatagramHeader DgHeader // ”CON0”
ConfigurationHeader ConfigHeader;
ConfigurationTransducer Transducer[];
};

struct DatagramHeader {
long DatagramType;
FILETIME ftTime;
};
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struct ConfigurationHeader {
char SurveyName[128]; // ”Loch Ness”
char TransectName[128]; // ”L0123”
char SounderName[128]; // ”EA 400”
float Motion x [m];
float Motion y [m];
float Motion z [m];
char Spare[116]; // future use
long TransducerCount; // 1,2,3,4
};

struct ConfigurationTransducer {
char ChannelId[128]; // Channel identification
long BeamType; // 0=SINGLE, 1=SPLIT
float Frequency; // [Hz]
float Gain; // [dB] - See note below
float EquivalentBeamAngle; // [dB]
float BeamWidthAlongship; // [degree]
float BeamWidthAthwartship; // [degree]
float AngleSensitivityAlongship;
float AngleSensitivityAthwartship;
float AngleOffsetAlongship; // [degree]
float AngleOffsetAthwartship; // [degree]
float PosX; // future use
float PosY; // future use
float PosZ; // future use
float DirX; // future use
float DirY; // future use
float DirZ; // future use
char Spare[128]; // Future use
};

float Gain: - The single Gain parameter was used actively in
raw data files generated with software version 1.3. This was
before PulseLengthTable, GainTable, and SaCorrectionTable
were introduced in software version 1.4 to enable gain and Sa
correction parameters for each pulse length.

NMEA datagram

This datagram contains the original NMEA 0183 input message
line; carriage return, line feed and a terminating zero included.

struct TextDatagram{
DatagramHeader DgHeader; // “NME0”
char Text[]; // ”$GPGLL,5713.213,N......”

};

The size of the datagram depends on the message length. An
example NMEA position message line is shown below:

$GPGLL,5713.213,N,1041.458,E<cr><lf>

The information contained in the VTG telegram is not used by
the echo sounder, and this information is thus only written to the
*.raw data file. (Format $--VTG,...)
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An example NMEA speed message line is shown below:

$HUVTG,245.0,T,245.0,M,4.0,N,2.2,K<cr><lf>

Annotation datagram

The annotation datagram contains comment text that has been
entered by the operator (”dangerous wreck”).

struct TextDatagram{
DatagramHeader DgHeader; // “TAG0”
char Text[]; // ”Dangerous wreck”

};

The text string is zero terminated. The size of the complete
datagram depends on the annotation length. The maximum
annotation string is 80 characters.

Sample datagram

The sample datagram contains sample data from just one
transducer channel. It can contain power sample data (Mode
= 0), or it can contain both power and angle sample data (Mode
= 1).

struct SampleDatagram
{

DatagramHeaderDgHeader; // “RAW0”
short Channel; // Channel number
short Mode; // Datatype
float TransducerDepth; // [m]
float Frequency; // [Hz]
float TransmitPower; // [W]
float PulseLength; // [s]
float BandWidth; // [Hz]
float SampleInterval; // [s]
float SoundVelocity; // [m/s]
float AbsorptionCoefficient; // [dB/m]
float Heave; // [m]
float Tx Roll; // [deg]
float Tx Pitch; // [deg]
float Temperature; // [C]
short Spare 1
Short Spare 2
float Rx Roll [Deg]
float Rx Pitch [Deg]
long Offset; // First sample
long Count; // Number of samples
short Power[]; // Compressed format - See below!
short Angle[]; // See below!

};

The sample data datagram can contain more than 32 768 sample
points.
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Short Angle - The fore-and-aft (alongship) and athwartship
electrical angles are output as one 16-bit word. The alongship
angle is the most significant byte while the athwartship angle is
the least significant byte. Angle data is expressed in 2’s
complement format, and the resolution is given in steps of
180/128 electrical degrees per unit. Positive numbers denotes
the fore and starboard directions.
Short Power - The power data contained in the sample
datagram is compressed. In order to restore the correct value(s),
you must decompress the value according to the equation below.

y = x 10log 2
256

where:
x = power value derived from the datagram
y = converted value (in dB)
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Out data file

Overview

The *.out file may contain one or more of the following
datagram types:
• CON0 - Echo sounder configuration datagram
• NME0 - Navigation input text datagram
• TAG0 - Text annotation
• DEP0 - Detected bottom depth
• SVP0 - Sound Velocity Profile
→ The SVP0 format is described on page 210.

Every *.out file contains a single configuration datagram. This
datagram is always the very first datagram in the file. Depth,
navigation and annotation datagrams constitute the remaining
file content. These datagrams are written to the file in an
undetermined order. Accordingly, strictly sequential time tags
are not guaranteed.
The code used to create the program is shown. Note that the
information following the “//” sign are comments to that line.

Echo sounder configuration datagram

The code used to create the datagram is shown.

struct ConfigurationDatagram {
DatagramHeader DgHeader // ”CON0”
ConfigurationHeader ConfigHeader;
ConfigurationTransducer Transducer[];
};

struct ConfigurationHeader {
char SurveyName[128]; // ”Loch Ness”
char TransectName[128]; // ”L0123”
char SounderName[128]; // ”EA 400”
char Spare[128]; // future use
long TransducerCount; // 1,2,3,4
};

struct ConfigurationTransducer {
char ChannelId[128]; // Channel identification
long BeamType; // 0=SINGLE, 1=SPLIT
float Frequency; // [Hz]
float Gain; // [dB] - See note below!
float EquivalentBeamAngle; // [dB]
float BeamWidthAlongship; // [degree]
float BeamWidthAthwartship; // [degree]
float AngleSensitivityAlongship;
float AngleSensitivityAthwartship;
float AngleOffsetAlongship; // [degree]
float AngleOffsetAthwartship; // [degree]
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float PosX; // future use
float PosY; // future use
float PosZ; // future use
float DirX; // future use
float DirY; // future use
float DirZ; // future use
float PulseLengthTable[5]; // Available pulse
lengths for the channel [s]
char Spare2[8]; // future use
float GainTable[5]; // Gain for each pulse
length in the PulseLengthTable [dB]
char Spare3[8]; // future use
float SaCorrectionTable[5]; // Sa correction
for each pulse length in the PulseLengthTable
[dB]
char Spare4[52]; // future use
};

float Gain: - The single Gain parameter was used actively in
raw data files generated with software version 1.3. This was
before PulseLengthTable, GainTable, and SaCorrectionTable
were introduced in software version 1.4 to enable gain and Sa
correction parameters for each pulse length.

Navigation datagram

The navigation datagram contains the original navigation input
message, with any carriage return and/or line feed included.

struct TextDatagram{
DatagramHeader DgHeader // ”NME0”
char Text[]; // ”$GPGLL,5713.213,N......”

};

The size of the datagram depends on the message length. An
example NMEA position message line is shown below:

$GPGLL,5713.213,N,1041.458,E<cr><lf>

Text annotation or event

The annotation datagram contains comment text that you have
entered (example: ”Dangerous wreck”).

struct TextDatagram{
DatagramHeader DgHeader // ”TAG0”
char Text[]; // ”Dangerous wreck”

};

The text string is zero terminated. The size of the complete
datagram depends on the annotation length. The maximum
annotation string is 80 characters.
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Detected bottom depth

The depth datagram contains depth that has been detected by the
echo sounder.

struct BottomDepthDatagram{
DatagramHeader DgHeader // ”DEP0”
long TransducerCount, // 1, 2, 3 ...
struct {

float Depth; // [m]
float Parameter1; // See Note 1 below
float Parameter2; // Future use

} Transducer[];
};

Note 1: Used for Bottom Surface Backscattering strength (dB)
A zero depth value implies that no bottom detection has been
made.
Note 2: When storing only one channel, the frequency will be
written at the end of the file name. Example for 38 kHz system:

L0000-D20050408-T11303400-EA 400-38.out

If storing two or more channels, the data will be stored in a
single file. Example:

L0000-D20050408-T11303400-EA 400-38-120.out
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xyz data file
The *.xyz file is an ASCII file datagram. It contains the
following information:
• x: Latitude
• y: Longitude
• z: Depth (in metres)
• Date (ddmmyyy)
• Time (hhmmss.ss)
An example is shown below:

1028.355268 5926.137550 20.54...01092005...161727.65
1028.355758 5926.137919 20.90...01092005...161727.85

Note 1: When storing only one channel, the frequency will be
written at the end of the file name. Example for 38 kHz system:

L0000-D20050408-T11303400-EA 400-38.xyz

If storing two or more channels, the data will be stored in a
single file. Example:

L0000-D20050408-T11303400-EA 400-38-120.xyz

Text data file

The *.txt file is an ASCII file datagram. It contains the
following information:
• Complete raw navigation telegram (can include HDT)
• Depth (date, time, depth, frequency)
An example is shown below:

$GPGGA,082012.98,5926.13995,N,01028.35856,S,1,08, ... *67
28071998,101433.30,19.58,38
28071998,101433.30,19.55.200 (if dual system)

GeoRef data file

The *.geo file is a text file datagram. It contains the following
informateion:
• Header

• Time
• Position (Lat/Long)
• Heading, across (only side looking SSG)
• Depth
• Channel number (only VGR)
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An example is shown below: (SSG with vertical depth)
SSG, 10124660, 5926.13995, N, 01028.35856, E, HDT 24.60, 48.90, 4.30
VGR, 10124660, 5926.13995, N, 01028.35856, E, 48.09.1
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Echogram data file
Refer to page 200 for the format description.
Note 1: When storing only one channel, the frequency will be
written at the end of the file name. Example for 38 kHz system:

L0000-D20050408-T11303400-EA 400-38.dg

If storing two or more channels, the data will be stored in a
single file. Example:

L0000-D20050408-T11303400-EA 400-38-120.dg
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NMEA datagrams

Overview

The following input datagram complies to the NMEA0183
protocol. The GLL, GGA and GGK datagrams are used for
navigational data input. The port and the baudrate is chosen in
the RS-232 Setup dialogue box.

GLL - Geographic position - latitude/longitude

Datagram format:
$--GLL,llll.ll,a,yyyyy.yy,a,hhmmss.ss,A,a*hh<CR><LF>
where (from left towards right):

Component Contents

llll.ll,a latitude, N/S

yyyyy.yy,a longitude, E/W

hhmmss.ss UTC of position

A status: A=data valid, V=data not valid

a*hh mode indicator

GXA - Transit position

Datagram format:
$--GXA,hhmmss.ss,llll.ll,a,yyyyy.yy,a,c--c,x*hh<CR><LF>
where (from left towards right):

Component Contents

hhmmss.ss UTC of position

llll.ll,a latitude, N/S

yyyyy.yy,a longitude, E/W

c----c Waypoint identification

x Satellite number
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GGA - Global positioning system fix data

Datagram format:
$--GGA,hhmmss.ss,llll.ll,a,yyyyy.yy,a,x,zz,p.p,g.g,M,
q.q,M,e.e,xxxx*hh<CR><LF>
where (from left towards right):

Component Contents

hhmmss.ss UTC of position

llll.ll,a latitude, N/S

yyyyy.yy,a longitude, E/W

x GPS quality indicator

zz Number of satellites in use, 00--12,
may be different from the number in view

p.p Horizontal dilution of precisison

g.g,M Altitude re: mean--sea--level (geoid), meters

q.q,M geoidal separation, meters

e.e age of differential GPS data

xxxx*hh differential reference station ID, 0000 to 1023

RTK / GGK format

The following formats will be read and used as navigation data
input:
$--GGK, ...
$PTNL, GGK, ...
To be configurated and entered in advanced navigation dialog
box:
$GPLLQ, ...
11 ... +000, ... (default programmed, Leica Total station)

VTG - Course over ground and ground speed

Datagram format:
$--VTG,x.x,T,x.x,M,x.x,N,x.x,K,a*hh<CR><LF>
where (from left towards right):

Component Contents

x.x,T Course over ground in True degrees

x.x,M Course over ground in Magnetic degrees

x.x,N Speed over ground in knots

x.x,K Speed over ground in km/hour
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a*hh mode indicator

Modes

A Autonomous mode

D Differential mode

E Estimated (dead reckoning) mode

M Manual input mode

S Simulator mode

N Data not valid

The positioning system mode indicator shall not be a null field!

ZDA - Time and date

Datagram format:
$--ZDA,hhmmss.ss,dd,mm,yyyy,zz,mm*hh<CR><LF>
where (from left towards right):

Component Contents

hhmmss.ss UTC of position

ss Day, 01 to 31 (part of UTC)

mm Month, 01 to 12 (part of UTC)

yyyy Year (part of UTC)

zz Local zone hours, 00 to +/-- 13 hours

mm Local zone minutes, 00 to +59

HDT - Heading

Datagram format:
$--HDT,x.x,T*hh<CR><LF>

where (from left towards right):

Component Contents

x.x,T Heading, degrees, True

Related topics

→ RS-232 Setup, page 141
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Annotation datagram
Both datagrams are available on the serial port, and on the
Ethernet interface provided that the local computer’s input port
is set to 10183, and that the correct IP address is used.

Annotation datagram 1

External annotations may be input via the Navigation serial port
as an NMEA datagram. It has the following format:
$??ATS,text string<CR><LF>
where (from left towards right):

Component Contents

?? identifier

ATS NMEA identifier (Annotation text String)

Text string free text string

<CR><LF> Carriage return and Line feed

The ASCII datagram with the external annotation must be
connected to the same serial line as the navigation system.

Annotation datagram 2

In addition to the $--ATS datagram, the old EA 500 datagram is
interpreted on input. For output the EA 500 version is used.
Datagram format:
CS,HHMMSShh Text string <CR><LF>
where (from left towards right):

Component Contents

HHMMSShh current time on computer

Text string free text string

<CR><LF> this sequence is only present on the serial line output

Example:
CS,10345561L1 Interesting object on bottom
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Remote Control datagram
The echo sounder can be remotely controlled by input through
the network or on a serial line. The following functions can be
controlled:
• Start/stop logging
An example is shown below:

PE,10504000,SYSTEM,STARTLOGGING CRLF
PE,10504000,SYSTEM,STOPLOGGING CRLF

• Start/stop pinging
An example is shown below:

PE,10504000,SYSTEM,STARTPINGING CRLF
PE,10504000,SYSTEM,STOPPINGING CRLF

• Start/stop history
An example is shown below:

PE,10504000,SYSTEM,STARTHIST CRLF
PE,10504000,SYSTEM,STOPHIST CRLF

Note 1: Capital letters must be used.
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Tide datagram (real time draft)
Datagram format:
$hTIDE,YYYYMMDDhhmm, x.x, hh CRLF

Data Description Format Vallid range

Start identifier = $ Always 24h

Talker identifier a Capital letter

Sentence fomater Always TIDE

Date/time of prediction/
measurment

YYYYMMDDhhmm 199601010000 to
999912312359

Tide offset in meters and
decimeters

x.x +327.661

Optional checksum *hh

End of sentence decimeter =
DRLF Always

0Dh 0Ah
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Output datagrams

Overview

The EA 400 echo sounder can provide the following output
datagrams:
• DBT - Depth below transducer

• DPT - Depth

• DBS - Depth below surface

• Simrad - Ping based ASCII datagram

• Simrad - Ping based binary datagram

• Atlas - Output telegram

• Echogram datagram

The NMEA datagrams can only provide depth information from
one channel. Which channel to use is selected in the Depth
Output dialogue box. The datagram type to be transmitted is
selected in the same dialogue box.

Related topics

→ Depth Output, page 98

DBT - Depth below transducer

This datagram exports the water depth relative to the transducer.
$--DBT,x.x,f,y.y,M,z.z,F*hh<CR><LF>
where (from left towards right):

Component Contents

-- don’t care

x.x,f water depth (in feet)

y.y,M water depth (in Meters)

z.z,F water depth (in fathoms)

hh checksum
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DPT - Depth

This datagram exports the water depth relative to the transducer
and offset of the measuring transducer. Positive offset numbers
provide the distance from the transducer to the waterline.
Negative offset numbers provide the distance from the
transducer to the part of the keel in interest. Note that the
“positive” distance from the transducer to the water line reflects
the distance from the transducer to the keel.

$--DPT,x.x,y.y,z.z*hh<CR><LF>

where (from left towards right):

Component Contents

-- don’t care

x.x depth from transducer (in meters)

y.y offset from transducer (in meters)

z.z maximum range scale in use

hh checksum

DBS - Depth below surface

This datagram exports the water depth referenced to the water
surface (DBS).

$--DBS,x.x,f,y.y,M,z.z,F*hh<CR><LF>

where (from left towards right):

Component Contents

-- don’t care

x.x,f water depth (in feet)

y.y,M water depth (in meters)

z.z,F water depth (in fathoms)

hh checksum

Simrad - Ping based ASCII datagram (serial)

This ASCII datagram exports the detected water depth measured
from the transducer face to the bottom backscatter value. The
set draft is included. One datagram is exported from each echo
sounder channel limited to four channels. The datagram has a
fixed length.
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D#,hhmmss.ss,xxxx.xx,zzz,TDN,ABS,<CR><LF>

where (from left towards right):

Component Contents

D Header (always)

# Channel number (1 characters)

hhmmss.ss time when transmitted (computer’s present time)

xxxx.xx Depth (in meters)

zzz Bottom surface backscattering strength (dB)

TDN Transducer number (never used!)

ABS Athwarthship bottom slope (in degrees)
(Not used in EA 400)

New format with tag “Add Frequency, Draft, SvP” activated:

D#,hhmmss.ss,xxxx.xx,zzz,TDN,ABS,FFF,D.DD,SSSS.S cc<CR><LF>

where (from left towards right):

Component Contents

D Header (always)

# Channel number (1 characters)

hhmmss.ss time when transmitted (computer’s present time)

xxxx.xx Depth (in meters)

zzz Bottom surface backscattering strength (dB)

TDN Transducer number (never used!)

ABS Athwarthship bottom slope (in degrees)
(Not used in EA 400)

FFF Add Frequency

D.DD Add draft

SSSS.S Add SvP

cc Checksum

Simrad - Ping based binary/ASCII datagram
(network)

The network output is either binary or ASCII. The binary
format is the same as for EA 500. The datagram has a fixed
length.

D#,HHMMSShh,
Depth,Reflectivity,Transducer no,Athwartships angle

where (from left towards right):
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Component Contents

D# header (2 characters), where # indicates the chan-
nel number

, separator

HHMMSShh 8 bytes -- time when ping is transmitted

, 1 character separator

Depth 4 bytes floating point number

Reflectivity 4 bytes floating point number

Transducer
no

4 bytes integral number

Athwartships
angle

4 bytes floating point number
(Not used in EA 400)

New format with tag “Add Frequency, Draft, SvP” activated,
binary:

D#,HHMMss.hh, Depth,Reflectivity, Frequency,
TransducerDepth,ConstantSvP

Component Contents

D# header (2 characters), where # indicates the chan-
nel number

, separator

HHMMSShh 8 bytes -- time when ping is transmitted

, 1 character separator

Depth 4 bytes floating point number

Reflectivity 4 bytes floating point number

Transducer
no

4 bytes integral number

Athwartships
angle

4 bytes floating point number
(Not used in EA 400)

Frequency 4 byte integral number

Transducer-
Depth

4 byte floating point number (Draft)

ConstantSvP 4 byte floating point number (SvP)

New format with tag “Add Frequency, Draft, SvP” activated,
ASCII:

D#,hhmmss.ss,xxxx.xx,zzz,TDN,ABS,FFF,D.DD.SSSS.S

Datagram specification, see Simrad-ping based ASCII
datagram, serial output.
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Atlas - Output datagram

This is a fixed length datagram exporting the water depth from
two channels. The datagram has a fixed length of 14 characters.
If two identical frequencies are used simultanously, the first
frequency (identfied as xx kHz - 1) is submitted with header
DB, while the other (xx kHz - 2) is submitted with header DA.
DBxxxxx.xxFM*
where (from left towards right):

Component Contents

D Always the character ’D’

B ’A’ for high frequency, ’B’ for low frequency

xxxx.xx Depth data

F ’Space’ or ’f’” (indicates Feet)

M ’m’ for meteres, ’f’ for feet

* One character asterix (*)
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Echogram datagram
The echogram datagram format is identical for both output to
the network and for file storage.
Due to protocol limitations the number of output samples is
limited to 700, while for file output the limit is 10000 samples.
Q#,HHMMSShh,TVG type,Depth,Pelagic Upper,
Pelagic Lower,Pelagic Count,Bottom Upper,
Bottom Lower,Bottom Count,Data
where (from left towards right):

Component Contents

Q# header with 2 characters, where # indicates the
channel number

, separator

HHMMSShh 8 bytes -- time when ping is transmitted

, 1 character separator

TVG type 4 bytes integral number, 0=No TVG, 3=20logR,
4=30logR, 2=40logR

Depth 4 bytes floating point number

Pelagic Upper 4 bytes floating point number

Pelagic Lower 4 bytes floating point number

Pelagic Count 4 bytes integral number

Bottom Upper 4 bytes floating point number

Bottom Lower 4 bytes floating point number

Bottom Count 4 bytes integral number

Data (Pelagic Count+Bottom Count)*2 bytes

where:
x = data (power value derived from the datagram)
y = converted value (in dB)
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Status datagram
A copy of the messages shown on the Status bar:
ST,HHMMSShh, Text string<CR><LF>
where (from left towards right):

Component Contents

ST header with 2 characters

, 1 character separator

HHMMSShh current time on computer

, 1 character separator

Text string Free text string

<CR><LF> this sequence is only present on the serial line out-
put

Example:
ST,10345561, Cannot meet specified ping interval.

Note Max 20 depth output. Each depth is separated by “,”.
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Georef Output datagram

Datagram format – side looking

SSG,HHMMSShh,xxxx.xxxxxxx,yyyy.yyyyyyy,type,hhh.hh,aaaa.aa,zzzz.zz
where (from left towards right):

Component Contents

SSG header with 3 characters

, separator

HHMMSShh 8 bytes -- time when ping is transmitted

, 1 character separator

xxxx.xxxxxxx Latitude

, 1 character separator

yyyy.yyyyyyy Longitude

type HDT or VTG

hhh.hh heading

aaaa.aa across range

zzzz.zz depht

Example:
SSG,10564020,5900.0177947,01000.0862086,HDT198.58,59.60,10.84
SSG,10564020,5900.0177947,01000.0862086,HDT198.58,59.60,0.0

Note Telegram without vertical depth, i.e. only side looking
transducers. The accross range will then only be range value.

In addition, the raw geographical reference datagram may be
relayed to a network recipient.

Datagram format – verical

VGR, HHMMSS,hh,xxxx.xxxxxxx,yyyy.yyyyyyy,zzzz.zz
where (from left towards right):
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Component Contents

VGR header with 3 characters

, separator

HHMMSShh 8 bytes -- time when ping is transmitted

, 1 character separator

xxxx.xxxxxxx Latitude

, 1 character separator

yyyy.yyyyyyy Longitude

, 1 character separator

zzzz.zz Range to selected point
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Navigation Output datagram
GL,HHMMSShh, Navigation string<CR><LF>
where (from left towards right):

Component Contents

GL header with 2 characters

, 1 character separator

HHMMSShh current time on computer

, 1 character separator

Navigation
string

Text string as set up in the navigation menu

<CR><LF> this sequence is only present on the serial line out-
put

Example:
GL,10345561,5925.08158,N,01028.34924,E
In addition, the relay navigation datagram output can be relayed
over serial line or to a network recipient.

Datagram format

$xxHeader,HHMMSShh,Completete navigation string CRLF
Example:
$GPGGA,10345561,5925.08158,N,01028.34924,E, ... *,hh
If the navigation telegram include for example heading HDT
and speed VTG, these data will be exported in addition.
If more than one NMEA, poition telegram input, all telegram
will be exported, for ecample GGA, GGL, GGK.
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Motion Sensor datagram

Network datagram

Network datagram is binary.
MS,HHMMSShh,Heave,Roll,Pitch
where (from left towards right):

Component Contents

MS header with 2 characters

, 1 character separator

HHMMSShh 8 bytes -- time when ping is transmitted

, 1 character separator

Heave 4 bytes floating point number

Roll 4 bytes floating point number

Pitch 4 bytes floating point number

Serial line datagram

Serial interface datagram is ASCII.
MS,HHMMSShh,h.hh,r.rr,p.pp<CR><LF>
where (from left towards right):

Component Contents

MS header with 2 characters

, 1 character separator

HHMMSShh 8 bytes -- time when ping is transmitted

, 1 character separator

h.hh heave value

r.rr roll value is 0.00

p.pp pitch value is 0.00



EA 400

206 857-160981 / J

Sound Speed datagrams

AML-CALC input

The AML CALC format is defined by Applied Microsystems
Ltd (AML) for use with their sensors. The format is ASCII, and
the datagram contains a five line header with a variable number
of data lines. For more information about this datagram format,
consult Applied Microsystems Ltd at their web site.
→ www.appliedmicrosystems.com.

1 CALC,sn,date,depth incr,depth disp
- where (from left towards right):

Component Contents

CALC identifier

sn sensor serial number

date current computer date

depth incr logging depth increment

depth disp depth display; depth units in meters or decibars

2 AML SOUND VELOCITY PROFILER S/N: xxxx
3 DATE:xxxxxx TIME:xxxxxx

- This line provides the julian date and time at the start
of the sensor logging.

4 DEPTH OFFSET (M):xxxx.x
- This line provides the pressure offset at the sea level.

5 ddd.d vvvv.v tt.t<LF>
- A variable number of lines provide the sound speed and

the temperature for different depths. Note that the
values are separated by spaces.

Component Contents

ddd.d depth in meters

vvvv.v velocity in meters pr second (m/s)

tt.tt temperature in degrees Celcius

To terminate the datagram, the last line must contain three
zeroes with two spaces between each zero.
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Kongsberg SSP10

The new format is completely in ASCII and allows 9998 entries
without limitations in resolution. In addition to depth and sound
speed, it allows input of absorption coefficient, pressure,
temperature and salinity or conductivity. The latter parameters
may be used to calculate depth, sound speed and absorption
coefficient. Use of a depth dependent absorption coefficient
allows a more accurate determination of bottom backscatter
strength. The format is:

$AA,Sxxx,yyyyy,nnnn,hhmmss,dd,mm,yyyy,
d.d,v.v,t.t,a.a,<CR><LF>
llll.ll,L,zzzzz.z,Z,p.p,text,*hh,\<CR><LF>

This format contains a fixed header (line 1 above), a repeated
cycle (line 2) and a postfix (line 3). The repeat cycle appears
“nnnn” times as defined in the header.

Component Contents

$ Start identfier, always 24h

AA Talker identifier, always AA

Sxx Datagram identifier, 4 characters, valid range from
S00 to S53. See notes 1 and 2.

yyyyy Data set identifier, valid range from 00000 to 65535

nnnn Number of measurements, max 9999

hhmmss UTC time of data acquisition, valid range 000000
to 235959. See note 3.

dd Day of data acquisition, 00 to 31. See note 3.

mm Month of data acquisition, 00 to 12. See note 3.

yyyy Year of data acquisition, 0000 to 9999. See note 3.

Start of repeat cycle, runs “nnnn” times. See note 4.

d.d Depth in meters from water level (valid range 0 to
12000.00), or Pressure in MPa (valid range 0 to
1.0000).

v.v Sound velocity in m/s. Valid range 1400 to 1700.00

t.t Temperature in degrees Celcius. Valid range --5 to
45.00

a.a Salinity in parts per thousand (valid range 0 to
45.00) or Conductivity in S/m (valid range 0 to
7.000).

<CR><LF> Carriage return and line feed to enad each of the
“nnnn” lines in the repeat cycle.

End of repeat cycle
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Component Contents

llll.ll Latitude in degrees and minutes, plus optional deci-
mal minutes. See note 5.

L Latitude N/S, valid characters “N” or “S”. See note
5.

zzzzz.zz Longitude in degrees and minutes, plus optional
decimal minutes. See note 5.

Z Longitude E/W, valid characters “E” or “W”. See
note 5.

p.p Atmospheric pressure in MPa. Valid range 0 to
1.0000. See note 5.

text Comments provided by operator, variable length.
See note 5.

*hh Optional checksum. See note 6.

\<CR><LF> Carriage return and Line feed to identify end of da-
tagram. Hex value = 5Ch 0Dh 0Ah

Note 1 - The datagram identifier identifies what type of data is
included. This is shown in the following table where D is depth,
P is pressure, S is salinity, C is conductivity, c is sound speed, α
is absorption coefficients, and L is latitude. The notation c(T,S)
indicates for example that the sound speed is to be calculated
from the temperature and salinity input data. When pressure is
used, the atmospheric pressure must be given if the pressure is
absolute, otherwise the pressure must be given re the sea level
and the atmospheric pressure must be zero.

Identifier Input data Data to be used

S00 D, c D, c
S10 D, c D, c
S11 D, c, α D, c, α
S12 D, c, T, S D, c, α(D,T,S,L)
S20 D, T, S D, c(D,T,S,L)
S21 D, T, S, α D, c(D,T,S,L), α
S22 D, T, S D, c(D,T,S,L), α(D,T,S,L)
S30 D, T, C D, c(D,T,C,L)
S31 D, T, C, α D, c(D,T,C,L), α
S32 D, T, C D, c(D,T,C,L), α(D,T,C,L)
S40 P, T, S D(P,T,S,L), c(P,T,S,L)
S41 P, T, S, α D(P,T,S,L), c(P,T,S,L), α
S42 P, T, S D(P,T,S,L), c(P,T,S,L), α(P,T,S,L)
S50 P, T, C D(P,T,C,L), c(P,T,C,L)
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Identifier Data to be usedInput data

S51 P, T, C, α D(P,T,C,L), c(P,T,C,L), α
S52 P, T, C D(P,T,C,L), c(P,T,C,L) , α(P,T,C,L)

Note 2 - S00 is a special case because then the sound speed
profile will be taken into use immediately without further
operator intervention. The checksum is then mandatory and
must be correct. Furthermore entries for zero depth and a deeper
depth than expected during the survey must be included.

Note 3 - Note that these fields have fixed length and leading
zeros must be used.

Note 4 - The depth or pressure field is always required while the
other fields are optional except for those required by the
datagram identifier. The field-delimiting commas must always
be included even if the fields are empty.

Note 5 - The positions, atmospheric pressure and comment
fields are optional. Note that the option field must not include a
\. It is recommended to include sensor type in the comment
field.

Note 6 - The checksum field is calculated between the $ and the
* delimiters by exclusive OR’ing of all bytes. The checksum is
required for datagram S00, but is optional for the others.

Simrad-A

When input is read, the nnnn number is used to convert the
profile. The number of m.mm and s.ss pairs must correspond to
this number to apply a complete profile. The format is:

SV,HHMMSShh,nnnn,m.mm,s.ss,m.mm,s.ss<CR><LF>

where (from left towards right):

Component Contents

SV header with 2 characters

HHMMSShh current time on computer

nnnn number of pairs in profile (NOTE!)

Start of repeat cycle, runs “nnnn” times.

m.mm depth of sound speed pair

s.ss sound speed

End of repeat cycle
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Optional sound speed sensors

The following sensors can also be read by the EA 400:
• AML SVPlus
• Sonar 2090
Refer to the manufacturer’s documentation for the sensor’s
format description.

Sound speed output
The following data format is used.
SV,HHMMSShh,nnn,m.mm,s.ss<CR><LF>
where (from left towards right):

Component Contents

SV header with 2 characters

HHMMSShh current time on computer

nnnn number of pairs in profile (NOTE!)

Start of repeat cycle, runs “nnnn” times.

m.mm depth of sound speed pair

s.ss sound speed

End of repeat cycle
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Attitude

Overview

The EA 400 echo sounder will accept attitude datagrams from
external sensors on the following formats:

• Sounder

• Binary, EM 1000 and EM 950 compatible

• Binary, EM 3000 and HiPAP compatible

Sounder

The Sounder protocol may be the most common interface for
heave, roll and pitch compensation. When you select this
protocol, the number of sensor variables is fixed, and there is no
token associated with it. However, baud rate and output rate
may be adjusted to fit your needs. The format is based on ASCII
characters, the datagrams have fixed length, and it is terminated
with a carriage return (CR) and line feed (LF).

:aabbbb shhhhxsrrrr spppp<CR><LF>

where (from left towards right):

Component Contents

aa Sway: 2 characters hex number with sway acceler-
ation, in 0.03835 m/ss units

bbbb Heave: 4 characters hex number with heave accel-
eration, in 0.000625 m/ss units

hhhh Heave: 4 characters decimal number with heave
position in centimeters, positive up

s 1 character with a <space> value if positive, or <-->
if negative

x Status character, check the comments below.

rrrr Roll: 4 character decimal number with roll angle in
hundres of a degree

s 1 character with a <space> value if positive, or <-->
if negative

pppp Pitch: 4 character decimal number with pitch angle
in hundres of a degree

s 1 character with a <space> value if positive, or <-->
if negative
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The definition of the attitude angles in this format is different
from the Euler angles definition used elsewhere. The difference
appears in the roll angle, where:

Rollechosounder = arcsinsin(RollEuler) cos(PitchEuler)

The various status characters have the following meaning:
U = Unaided mode and stable data. (The sensor operates
without external input data.)
u = Unaided mode but unstable data. (The sensor is without
external input data, but the data from the sensor is unstable. A
probable cause for this is the lack of alignment after the sensorr
has been switched on restarted. The alignment period from a
power recycle is normally approximately five minutes.)
G = Speed aided mode and stable data. (The sensor operates
with external input of speed data.)
g = Speed aided mode but unstable data. (The sensor operates
with external input of speed data, but the data from the sensor is
unstable. A probable cause for this is the lack of alignment after
the sensor has been switched on restarted, or a failure in the
speed data input.)
H = Heading aided mode and stable data. (The sensor operates
with external input of heading data.)
h = Heading aided mode but unstable data. (The sensor operates
with external input of heading data, but the data from the sensor
is unstable. A probable cause for this is the lack of alignment
after the sensor has been switched on restarted, or a failure in
the heading data input.)
F = Full aided mode and stable data. (The sensor operates with
external input of both speed and heading data.)
f = Full aided mode but unstable data. (The sensor operates with
external input of heading and speed data, but the data from the
sensor is unstable. A probable cause for this is the lack of
alignment after the sensor has been switched on restarted, or a
failure in the heading and/or speed data input.)
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Binary EM 1000 / EM 950 compatible

This format consists of a fixed length message using single byte
unsigned, 2-byte unsigned and 2-byte two-complement integer
data elements. For the 2-byte elements, the least significant byte
is transmitted first.

Element Scaling Format Bytes Value

Header -- Unsigned 1 00 Hex

Header -- Unsigned 1 90 Hex

Roll 0.01 deg Integer 2 --999 to +999

Pitch 0.01 deg Integer 2 --999 to +999

Heave 1 cm Integer 2 --999 to +999

Heading 0.01 deg Unsigned 2 0 to 35999

• Roll is positive with port side up.
• Pitch is positive with bow up.
• Heave is positive up.
Invalid data are indicated by values outside the specified ranges.
The definition of the attitude angles in this format is different
from the Euler angles definition used elsewhere.

Binary EM 3000 / HiPAP compatible

This format consists of a fixed length message using single byte
unsigned, 2-byte unsigned and 2-byte two-complement integer
data elements. For the 2-byte elements, the least significant byte
is transmitted first.

Element Scaling Format Bytes Value

Status byte -- Unsigned 1 See below

Header -- Unsigned 1 90 Hex

Roll 0.01 deg Integer 2 --999 to +999

Pitch 0.01 deg Integer 2 --999 to +999

Heave 1 cm Integer 2 --999 to +999

Heading 0.01 deg Unsigned 2 0 to 35999
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• Roll is positive with port side up.
• Pitch is positive with bow up.
• Heave is positive up.
The status byte may have the following values:
90 Hex = Normal
91 Hex = Reduced performance
A0 Hex = Invalid data
Invalid data are indicated by values outside the specified ranges.
When the status is A0, the values within the specified ranges are
valid, but may suffer from reduced quality.
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Temperature sensor - output
The datagram format is:
$--MTW,x.x,C*hh<CR><LF>
where (from left towards right):

Component Contents

MTW Header

x.x temperature in Degrees Celcius

C*hh Checksum

<CR><LF> Carriage return and Line feed terminates the data-
gram.
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